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Лабораторная работа №1 
 

Освоение приемов работы с графическим редактором 
векторной графики CorelDRAW Suite 12 

 
В работе осваиваются инструментальные средства графического редактора 

для рисования векторных объектов и подготовки точных макетов. Отрабатыва-
ются особенности 12-й версии: инструменты «умного» рисования, удаление ог-
раниченных фрагментов кривой и др. 

Цель работы 
1. Узнать возможности и назначение инструментов рисования CorelDRAW: 

Указатель, Форма, Масштаб, Свободная рука, Прямоугольник, Эллипс, 
Многоугольник, Простые формы, Текст, Интерактивное перетекание, Пи-
петка, Контур, Заливка, Интерактивная заливка. 

2. Ознакомиться с: 
– рабочим пространством и вспомогательными средствами по его органи-

зации; 
– диспетчером объектов и цвета: окно «Object Manager»; 
– установкой параметров страницы (ориентация, поля, фон, размеры, виды 

макета) и режимом просмотра документов (простой каркас, каркас, черновик, 
обычный, улучшенный). 

3. Освоить: 
– выделение объектов (отдельных объектов в группе, всех объектов, объ-

ектов с определенными свойствами) и выделение узлов для преобразования 
формы объектов; 

– преобразование объектов (масштабирование, вращение, наклон, растя-
жение и сжатие, копирование, дублирование, клонирование); 

– работу с комбинированными объектами (объединение, пересечение и ис-
ключение, группирование, комбинирование, слияние), с преобразованием объ-
ектов в набор кривых, с блокировкой и разблокировкой объектов; 

– работу со слоями (создание нового слоя при помощи диспетчера объектов, 
назначение видимости слоя, перемещение объектов со слоя на слой, редактиро-
вание объектов, находящихся на разных слоях).  

Назначение и возможности пакета CorelDRAW 12. Графические прило-
жения от корпорации Corel традиционно являются популярными. Несмотря на 
большую конкуренцию с программами от Adobe, пакет CorelDRAW использует-
ся в допечатной подготовке многими издательствами. Это обусловлено широки-
ми возможностями программы. CorelDRAW 12, как и его предшествующие вер-
сии, позволяет создавать самые разные дизайнерские и полиграфические 
проекты: от небольших рекламных буклетов до многостраничных брошюр; от 
визиток до плакатов; от простейших графических рисунков до полноцветных 
картин и элементов оформления веб-сайтов. При этом благодаря дружественно-
му и интуитивно понятному интерфейсу, CorelDRAW 12 значительно проще ос-
воить, чем программы векторной графики других производителей. 
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Элементы теории компьютерной графики 
 

1.1. Цвет в веб-дизайне 
 

Мы живем в цветном мире и находимся в плену цветов. Психологическое 
восприятие предмета связано с его окраской, причем связано достаточно жестко. 
Однако есть некоторые универсальные законы выбора цвета, которые в сочета-
нии с остальными законами композиции необходимо знать. При использовании 
цвета в компьютерной графике необходимо четко чувствовать разницу не только 
в цветах, но и в тончайших оттенках, понимать, как их применение будет влиять 
на восприятие графического образа и проекта в целом. Чтобы создать гармонич-
ную цветовую композицию, необходимо знать характеристики цветов. 

Несмотря на то, что цвет, в отличие от формы, понятие субъективное, су-
ществуют вполне универсальные законы его использования, которые дизайнер 
должен знать и применять на практике. Из существующих цветовых моделей 
лишь модель HSB (Hue–Saturation–Value, тон–насыщенность–яркость) пред-
ставляет естественные свойства любого оттенка и не требует привыкания. 

Восприятие цвета. Нужно отметить, что не только различные люди реа-
гируют на один и тот же цвет по-разному, но и целые народы. В разных странах 
различаются описание и восприятие цвета, что обусловлено национально-
культурными традициями. Этим частично и объясняется то многообразие спо-
собов описания цвета, с которым приходится сталкиваться любому человеку, 
профессионально работающему с компьютерной графикой. 

Цвет – это эмоции и настроение. Схема основного деления цветов с точки 
зрения восприятия на холодные и теплые представлена на рис. 1.1. Это деление 
условно: чем ближе цвет к границам верхнего и нижнего полукругов, тем менее 
точно он относится к теплым или холодным. 

Красный. У большинства людей красный цвет вызывает ассоциацию с ог-
нем. Поэтому и действие данного цвета – от ощущения тепла до страха. Он спо-
собен ускорять пульс и расширять зрачки, однако из-за своей яркости достаточ-
но быстро утомляет, особенно если присутствует в больших количествах 
(например если это цвет стен в помещении). Чистый красный цвет – это цвет 
тревоги и возбуждения, однако некоторые его оттенки (коричневый, тепло-
бежевый) действуют успокаивающе. Красный цвет привлекает к себе внимание 
(не случайно почти все предупреждающие надписи сделаны либо на красном 
фоне, либо красными буквами). Этот цвет часто применяется в компьютерной 
графике, однако с ним нужно быть осторожным, чтобы не перестараться. 

Желтый. Это самый яркий цвет на цветовом круге. Он идеально подходит 
для передачи радостного настроения, оптимизма. Именно поэтому желтый – 
один из наиболее часто используемых цветов в рекламе туристических компа-
ний. Кроме того, желтый цвет – это цвет золота. Поэтому у многих он ассоции-
руется с успехом, богатством и роскошью. 

Оранжевый. Тёплый, позитивный, яркий и современный цвет, оказываю-
щий бодрящее влияние, ускоряет пульс и расширяет зрачки, один из наиболее 
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часто используемых цветов в современном дизайне (особенно веб-дизайне). Для 
создания яркого плаката оранжевый фон – банальный, но практически идеаль-
ный вариант. Оранжевый цвет очень хорошо смотрится в сочетании с голубым. 

Зелёный. Удивительный цвет. Он может быть как теплым, так и холод-
ным, однако чаще он находится на стыке, поэтому его можно отнести как к хо-
лодной, так и к теплой группе. Зеленый оказывает успокаивающее воздействие, 
понижает давление, нормализует кровообращение. Это самый природный и са-
мый «живой» цвет. Именно в этом и состоит его основное назначение в дизайне 
– передавать связь объекта с природой. На логотипах зеленый цвет встречается 
в основном либо у компаний, добывающих природные ресурсы, либо у эколо-
гических организаций. Кроме того, зеленый цвет достаточно загадочный. Этот 
цвет связан с подсознательными ассоциациями человека.  

Голубой. Голубой цвет успокаивает и охлаждает. Подобный эффект объ-
ясняется ассоциациями с холодной водой и льдом. Порой вызывает чувство от-
чужденности. 

Синий цвет находится в самом низу цветового круга и относится к холод-
ной группе (успокаивает, навевая меланхоличное настроение). Этот цвет можно 
отнести к цветам зоны «вечной мерзлоты». Он идеально передает ощущение 
холода и чистоты, действует успокаивающе, хорошо подходит для дизайна спа-
лен. Варьирование насыщенности и яркости чисто синего цвета может дать 
большую гамму оттенков. Правда, из-за особенностей системы CMYK именно 
синий цвет хуже всего отображается при печати.  

Фиолетовый. Это очень тяжелый для восприятия цвет, так как в природе 
он практически не встречается. Фиолетовый цвет, как синий и голубой, отно-
сится к холодной группе. Он способен создавать ощущение тесноты, ограни-
ченности пространства, а также очень быстро утомлять и приводить к сниже-
нию активности. Фиолетовому цвету присуща некая загадочность.  

Главные цвета: черный и белый. Чёрный цвет – тяжелый цвет, несущий 
в себе тоску, горечь. Вызывает чувство усталости и дискомфорта. Несмотря на 
это, довольно часто люди выбирают одежду такого цвета. В данном случае он 
относится к «классике» и при этом создает определённый стиль. Этот цвет мо-
жет сочетаться со всеми другими цветами той или иной степени интенсивности. 
Черный – это цвет роскоши, особенно в сочетании с красным. Славяне тради-
ционно относят его к траурному цвету. 

Белый – очень радостный цвет. Благодаря ассоциации с воздухом, вызы-
вает чувство лёгкости, свободы и невесомости. Ускоряет пульсацию и расши-
ряет зрачки. Белый цвет довольно часто используют для создания фона. Сам по 
себе белый цвет не несёт информации, а со всеми остальными цветами доста-
точно хорошо компонуется, создавая более светлые тона. Белый цвет считается 
цветом невинности и чистоты. 

Вопрос о сочетаемости цветов – один из самых спорных и неоднозначных 
в дизайне. Действительно в данном случае, как нигде, силён принцип «о вкусах 
не спорят». Поэтому говорить об универсальных правилах, к сожалению, не 
приходится. Однако некоторые закономерности все же можно выделить. 
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Итак, первый и наиболее простой принцип – выбор близких оттенков. 
Точно так же, как одежда подбирается в тон, могут быть подобраны и цвета, 
например, для веб-сайта. 

В профессиональных графических работах обычно используется схема 
(рис. 1.2) для поиска совместимых оттенков согласно следующим правилам: 

– смежные цвета неплохо сочетаются, выбор такого варианта обычно счи-
тается скучным и банальным; 

– цвета, которые находятся друг напротив друга, считаются мало совмес-
тимыми. Единственное исключение – синий цвет неплохо смотрится в паре с 
желтым; 

– лучший выбор – цвета через один, те, которые на рис. 1.2 связаны пря-
мыми линиями. Они отлично сочетаются в большинстве своих оттенков, глав-
ное, чтобы не было большого контраста в яркости. 

 

  
 

Рис. 1.1. Цветовой круг, показывающий 
разделение цветов на холодные и теплые 

 
Рис. 1.2. Отношение сочетаемости цветов  

в цветовом круге 
 
Чёрный и белый практически идеально сочетаются со всеми другими цве-

тами и особенно друг с другом. Поэтому всегда проще сделать работу именно в 
этих цветах. Но всё же главным ориентиром при подборе цветовой гаммы дол-
жен оставаться вкус (если повезло от рождения) и опыт (нарабатывается со 
временем). Ведь существует множество решений, которые не вписываются в 
рамки никаких цветовых теорий, однако являются примером качественной и та-
лантливой дизайнерской работы. 

Цветовой круг применяется для образования гармоничных сочетаний из 
двух, трех, четырех цветовых тонов. Он дает более полную возможность соста-
вить необходимые сочетания. Например: если в композиции имеется предмет с 
насыщенным цветом, то к нему можно подобрать другой предмет, цвет которо-
го усилил бы ощущение насыщенности цвета первого. 

Выбор цветов одной композиции основан на том, что именно вы стремитесь 
подчеркнуть: единство или контраст. В первом случае выбираются цвета, близ-
кие друг к другу на цветовом круге, во втором – на расстоянии примерно четверти 
окружности. Нельзя пользоваться цветами, расположенными слишком близко 
друг к другу, – диссонанс между такими цветами буквально бьет по глазам. С дру-
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гой стороны, прямо противоположные цвета тоже редко образуют гармоничные 
пары – зеленый с фиолетовым или красный с голубым обычно кажутся слишком 
разнородными (относительно неплохо сочетается только синий с желтым). Таким 
образом, лучше всего сочетаются и контрастируют друг с другом цвета, располо-
женные приблизительно на расстоянии четверти окружности друг от друга. 

На особенности восприятия каждого цвета и цветовых сочетаний можно 
построить целый ряд готовых схем. Каждая из этих схем, будучи реализован-
ной, вносит определенное настроение в композицию графического проекта. 

Когда мы хотим добиться гармоничного сочетания цветов, то можно взять 
близлежащие, расположенные один за другим на цветовом круге, например, 
желто-красный, желтый и желто-зеленый. Для создания контраста выбирают 
цвета противоположные, расположенные напротив друг друга. Такие цвета на-
зываются дополняющими. Примененные рядом, они делают друг друга ярче и 
живее. Пары: желтый-фиолетовый, пурпурный-зеленый – примеры дополняю-
щих цветов. Кроме использования цветов, расположенных рядом, можно по-
пробовать использовать одни и те же цвета, но разной степени насыщенности. 
Однако самый надежный и неисчерпаемый источник цветовых схем – природа. 
Ничто так не радует наш глаз, как гармония естественной нежности и красоты. 

По-разному воспринимается цвет в зависимости от того, какую форму и 
площадь он занимает и какие другие цвета его окружают. При уменьшении за-
нимаемой цветом площади количество оттенков, которые глаз способен разли-
чить, уменьшается и большинство цветов начинает выглядеть более тусклыми 
и темными, особенно если их яркость и насыщенность и без того не были мак-
симальными. На практике это означает, что для небольших по размеру элемен-
тов нужно выбирать более яркие, «примитивные» цвета, а для того чтобы пока-
зать всю красоту какого-нибудь темного, слабонасыщенного оттенка, 
необходима достаточная площадь (например, фон всей страницы). 

Любые два цвета в близком соседстве воспринимаются несколько иначе, чем 
по отдельности. Художники знают, что предметы материального мира связаны 
сложными цветовыми отношениями, – например, они бросают друг на друга реф-
лексы (отраженный свет) и окрашенные тени. Если цвета-соседи обладают при-
мерно одинаковой яркостью, то они склонны обмениваться насыщенностью и 
цветом. Непосредственно возле границы двух цветов начинает проявляться про-
тивоположная тенденция – цвета как бы «отталкиваются» друг от друга, старают-
ся подчеркнуть свои различия; более темный цвет в соседстве с более светлым 
приобретает еще более темную «кромку», а светлый возле самой границы делает-
ся несколько ярче. Такое влияние цветов друг на друга, приводящее к усилению 
контраста между ними, заметнее всего тогда, когда цвета-соседи сильно различа-
ются по яркости. На ярком белом фоне почти любой темный цвет становится чер-
ным, а на темном или черном фоне особенно контрастно смотрятся яркие и насы-
щенные цвета, тогда как темные и ненасыщенные выглядят бледновато. 
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1.2. Информационные модели изображений и объемных объектов 
 

В компьютерной графике используются три класса информационных моде-
лей: пиксельная (или точечная) модель изображения, векторная (или объектная) 
модель изображения и сетчатая модель трехмерного объекта. Рассмотрим первый 
и второй класс моделей подробнее, поскольку их устройство и особенности ока-
зывают огромное влияние на все аспекты работы с графическими программами.  

Пиксельная модель представляет собой описание с помощью структур 
данных собственно изображения, которое формируется в оптической системе 
глаз зрителя. В пиксельной модели изображение рассматривается как растр – 
регулярная сетка, покрывающая собой всю плоскость изображения. Регуляр-
ность растра означает, что все его ячейки имеют одинаковые форму и размеры. 
В принципе ячейки растра могут быть треугольными, шестиугольными и даже 
неправильной формы, на практике работают только с квадратными растрами. 
Часть изображения, размещенная в пределах одной ячейки растра, называется 
пикселом. В простейшем варианте точечная модель представляет собой после-
довательность описаний всех пикселов изображения – дескрипторов. 

Обычно дескрипторы располагаются в памяти компьютера в порядке сле-
дования пикселов по строкам (как в телевизионном изображении) или столбцам 
растра. В зависимости от степени детальности описания пиксела каждому деск-
риптору отводится тот или иной объем памяти. Различные пикселы изображе-
ния отличаются друг от друга только цветом. Содержание дескриптора и его 
размеры целиком определяются способом представления информации о цвете, 
принятом в используемой информационной модели.  

С точечными изображениями связана одна особенность физиологии чело-
веческого зрения – смыкание. Она состоит в том, что при рассматривании двух 
довольно удаленных мелких объектов они сливаются в один. Границы проявле-
ния смыкания зависят от остроты зрения и лежат в пределах от 0,7 до 1,5 се-
кунды углового расстояния между предметами. 

Благодаря смыканию вполне слитными изображениями воспринимаются 
мозаики, картины импрессионистов, фотографии в газетах и телевизионные 
кадры. Но с более близкого расстояния или через увеличительное стекло видно, 
что все это – точечные изображения, составленные из пикселов. Смыкание по-
могает с помощью черного тонера, заправленного в картридж лазерного прин-
тера, получать большое число оттенков серого цвета.  

Достоинства пиксельной модели 
– Пиксельную модель существующих изображений легко построить авто-

матически путем сканирования или фотосъемки.  
– Пиксельное изображение можно редактировать на любом уровне гло-

бальности – от одновременного изменения характеристик всех его пикселов 
(например при коррекции яркости) до воздействия на любой отдельно взятый 
пиксел (например при устранении артефактов). 

– Процедура преобразования пиксельной модели в изображение при выво-
де на экран или печать ориентирована именно на этот класс моделей изображе-
ния (все мониторы, струйные и лазерные принтеры, ризографы).  
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Недостатки пиксельной модели 
Основной недостаток – жестко фиксированное количество пикселов в рас-

тре. Поэтому при увеличении размеров изображения приходится увеличивать 
размеры каждого из пикселов. При достаточно большом увеличении исчезает 
эффект смыкания и изображение превращается в скопление пятен. Еще раньше 
появляется видимая зазубренность кромок изображения.  

– Более или менее значительное уменьшение размеров пиксельного изо-
бражения при сохранении числа пикселов приводит к тому, что устройство 
воспроизведения информации оказывается неспособным отобразить слишком 
маленькие пикселы и часть графической информации утрачивается. При сохра-
нении размеров пикселов уменьшить изображение можно только выбрасывани-
ем из него некоторых пикселов, что приводит к тому же эффекту. 

– После сканирования полиграфического изображения на нем может поя-
виться муар – полосы, точки или клетки. Это явление вызывается интерферен-
цией, возникающей при наложении друг на друга двух растров. Избавиться от 
муара, не снижая четкости изображения, непросто. 

– В пиксельной модели отсутствует внутренняя структура, соответствую-
щая семантике изображенных объектов. Все изображения после перевода в то-
чечную модель превращаются в совокупность цветных пикселов. 

– При необходимости высокой четкости и точной передачи цвета точечная 
модель требует для своего хранения и обработки большого объема памяти – де-
сятков и сотен мегабайтов.  

Благодаря очевидным достоинствам пиксельной информационной модели 
пиксельные изображения доминируют в проектах художественной компьютер-
ной графики. Для частичного преодоления существенных недостатков пиксель-
ной модели в ее состав вводятся дополнительные структурные элементы, такие 
как слои и альфа-каналы. Кроме того, в качестве дополнительных структурных 
элементов расширенной точечной модели часто используются объекты вектор-
ной графики (например контуры и векторные тексты). 

 
1.3. Объекты и особенности векторной модели. Форматы векторной 

графики 
 
У пиксельной и векторной моделей имеется общая черта – обе они предна-

значены для представления плоского (двухмерного) изображения. При работе 
над многими графическими проектами вполне можно обойтись одной из них или 
сочетанием обеих. В отличие от пиксельной модели, в векторной модели струк-
туры данных соответствуют более крупным и семантически нагруженным объ-
ектам изображения или виртуального мира. Предельно упрощая ситуацию, мож-
но считать, что структуры данных векторной модели изображения 
соответствуют разомкнутым линиям или замкнутым контурам, из которых со-
ставляется изображение. Каждая такая структура соответствует независимому 
объекту. Объекты не связаны между собой, поэтому они могут накладываться, 
частично или полностью заслоняя друг друга. Их можно легко перемещать, из-
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менять форму или цвет. Кроме имени, которое можно соотнести с векторным 
графическим объектом, и типа объекта, который определяет его «устройство», у 
каждого объекта имеется несколько атрибутов – параметров, задающих его гео-
метрические и цветовые характеристики. Любой из объектов векторного изо-
бражения можно преобразовывать (перемещать, масштабировать, изменять зна-
чения атрибутов) как совместно с другими объектами, так и независимо от них. 

Дескрипторы объектов, составляющих векторную модель, неодинаковы – 
их структура и размеры зависят от типа объекта, которому дескриптор соответ-
ствует, и значений его атрибутов. Например, описание линии (контура), прохо-
дящей через три точки, займет в памяти меньше места, чем описание линии, 
проходящей через триста точек. Для описания цвета объектов векторной модели 
используются те же модели представления цвета, что и для пиксельной модели. 
Векторность представления линии состоит в том, что описываются только ос-
новные точки линии, а все промежуточные достраиваются между ними по опре-
деленным математическим законам. Например, если необходимо нарисовать от-
резок прямой, можно указать только координаты концов отрезка, а также сделать 
пометку о том, что соединяющая их линия – «прямая». Для описания окружно-
сти достаточно задать ее центр, указать радиус и сделать пометку «окружность». 
Аналогичным образом кодируются цвет объекта, толщина линий и др. В таком 
виде информация хранится в файле, а при отображении графического векторного 
элемента на мониторе, бумаге или другом носителе элементы изображения авто-
матически строятся в соответствии с инструкциями (рис. 1.3). 

Для описания векторного графического объекта существует множество 
способов. Самый удобный и распространенный из них – это так называемые 
«кривые Безье», разработанные французским инженером-математиком Пьером 
Безье для решения узкоспециальной задачи – простого описания криволиней-
ных фигур для машин по раскройке листового металла. Способ оказался на-
столько удачным, что очень скоро завоевал популярность далеко за пределами 
инженерной графики. 

 

  

Рис. 1.3. Описание прямоугольника 
на языке Роsscript 

Рис. 1.4. Фрагмент кривой Безье 

 
Вкратце его суть сводится к следующему. Любая одномерная геометриче-

ская фигура разбивается на сегменты. Каждый сегмент начинается и заканчива-
ется особой якорной точкой. В файле явно указываются координаты якорных 
точек, а также первая и вторая производная выходящего из них сегмента. На 
рис. 1.4 показан фрагмент кривой Безье. Якорные точки – это маленькие белые 
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квадратики 1, из которых выходят вспомогательные прямые отрезки 2. Эти от-
резки называются направляющими линиями. Каждая направляющая заканчива-
ется чёрной точкой – маркером 3, её длина и направление соответствуют пер-
вой и второй производной. Если необходимо изменить форму сегмента, 
достаточно потянуть маркер соответствующей направляющей. 

Достоинства векторной модели 
– Для размещения векторной модели изображения в памяти компьютера и 

в файле не требуется много места, поскольку хранятся сведения о типах и зна-
чениях аргументов объектов. Компьютер работает с этой компактной моделью, 
выполняя преобразование в пиксельное изображение только перед выводом на 
экран монитора или на печать. Цветовые характеристики изображения практи-
чески не оказывают влияния на размеры его векторной модели. 

– Векторное изображение может быть структурировано с произвольной 
степенью детализации, поскольку любому элементу изображения при желании 
можно соотнести отдельный объект (или группу объектов) векторной модели. 
Это позволяет очень быстро выбирать для работы нужные части изображения. 

– Объекты векторной модели изображения легко преобразовываются, их 
масштабирование не влечет за собой ни искажения изображения, ни утраты ви-
зуальной информации. Поэтому качество полученного векторного изображения 
всегда будет зависеть только от возможностей устройства вывода. 

– Отдельную категорию объектов представляет собой текст. Это обеспечи-
вает возможность гибкой настройки соответствия текста изображению, быст-
рой корректировки как самого текста, так и параметров, управляющих его фор-
матированием, на любой стадии работы. 

Недостатки векторной модели 
– На освоение приемов работы с программой векторной компьютерной 

графики требуется несколько больше времени, чем на освоение инструментов 
программы точечной графики. 

– Построение векторной модели изображения представляет собой задачу, 
плохо поддающуюся автоматизации. Хотя программы трассировки предостав-
ляют принципиальную возможность построения векторной модели по точечно-
му изображению, на практике большая часть векторных моделей составляется 
непосредственно пользователями из-за принципиальных ограничений автома-
тической трассировки. 

– Векторная модель изображения не дает пользователю инструментов, соот-
ветствующих традиционной технике живописи. Векторные изображения выгля-
дят резко, плоско, «мультяшно». Для создания векторной модели реалистическо-
го изображения требуются немалые навыки работы с программами векторной 
графики и огромное количество объектов, составляющих такую модель. 

Следует отметить, что процесс эволюции программ векторной графики 
наиболее быстро движется именно в направлении повышения реалистичности 
векторных изображений, и новые объекты векторной модели (сетчатые залив-
ки, тени, градиентная прозрачность) в значительной степени расширяют изо-
бразительные возможности векторной графики. 
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В заключение сравнения точечной и векторной моделей изображений сле-
дует отметить, что в современных графических программах четко прослежива-
ется тенденция к их совместному использованию. Практически все современ-
ные программы для работы с векторной графикой позволяют не только вводить 
в состав векторной модели объекты, соответствующие импортированным пик-
сельным изображениям, но и предусматривают довольно обширные наборы ин-
струментов для редактирования таких изображений.  

Основные форматы векторной графики. Каждый уважающий себя разра-
ботчик программы векторной графики считает своим долгом создать собствен-
ный формат представления данных. В основе каждого из них лежит всё та же 
идея кривых Безье, но конкретные варианты отличаются друг от друга настоль-
ко, что сейчас достаточно остро встаёт проблема совместимости форматов. 

CDR. Основной формат программы CorelDRAW. Способен хранить не 
только элементы векторной графики, но и точечные изображения, текст, эф-
фекты и др. Если хотите добиться максимальной совместимости файлов в фор-
мате CDR с другими программами (например с программами для верстки), со-
храняйте работы в формате более ранних версий программы, допустим, 
восьмой. 

Adobe PostScript. В настольных издательских системах фактически является 
стандартом отрасли. Первоначально он был разработан как язык представления 
страницы для высококачественных выводных устройств (лазерных принтеров и 
фотонаборных автоматов), но сегодня широко применяется и в программах верст-
ки, и в графических пакетах. Использует как векторный, так и растровый способы 
записи информации. Последняя версия языка PostScript (Level 3) позволяет рабо-
тать с такими сложными эффектами, как прозрачность, печать уровня Нi-Fi (в том 
числе, Pantone Hexochrome), поддерживает 4096 градаций каждого цвета и т. д. 
Существует несколько разновидностей PostScript, самый известный из которых – 
EPS (Encapsulated PostScript). Другой, бурно развивающийся сегодня вариант язы-
ка, – PDF (Adobe Portable Document Format) – формат программы Adobe Acrobat. 
По сути, представляет собой упрощенную и оптимизированную версию PostScript. 
Документ Adobe Illustrator также является PostScript-файлом. 

DXF (Drawing eXchange Format). Формат предназначен для использова-
ния в системах автоматизированного проектирования, прежде всего AutoCAD. 
В DXF реализованы многие возможности, отсутствующие в большинстве дру-
гих форматов, например хранение трехмерных объектов. 

WMF (Windows MetaFile). Изначально был создан для обмена данными 
между Windows-приложениями. Формат вполне подходит для использования в 
программах офисного уровня, но слишком примитивен для того, чтобы приме-
няться в настольных издательских системах. Более функциональный вариант 
WMF, который появился вместе с Windows 95 и называется EMF (Enhanced 
MetaFile), так и не получил широкого распространения. 

PICT. Аналог формата WMF для платформы Macintosh. Формат имеет все 
те же недостатки, что и его аналог в Windows, умноженные на малую распро-
странённость компьютеров Macintosh Apple. 
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1.4. Методические указания по работе в пакете CorelDRAW 12 
 

Основу изображения в CorelDRAW составляет множество отдельных эле-
ментов, называемых объектами. Простейшими объектами являются: прямая, 
круг, прямоугольник, замкнутая кривая, многоугольник и др. Сложный рисунок 
состоит из набора объектов. Также с помощью комбинаций объектов можно 
создавать другие объекты или группы объектов. Объединив объекты в группы, 
над ними можно выполнять те же операции, что и над отдельными объектами. 
На границах всех объектов имеется определенное количество специальных то-
чек-узлов. Параметры узлов и сегментов определяют внешний вид и создают 
контур объекта. Различают замкнутые и открытые контуры. Область внутри 
объекта с замкнутым контуром можно залить или закрасить цветом, текстурой 
или узором. К объектам с открытым контуром заливку применить нельзя. Сам 
контур объекта также имеет цвет и толщину. 

1. Для работы с программой понадобится освоение следующих понятий: 
Объект – независимый элемент изображения. Комбинация нескольких 

объектов может создавать новый объект. Изображения состоят из объектов. 
Контур – внешняя граница объекта. Контуры бывают открытыми и замк-

нутыми. 
Заливка – заполнение контура цветом. Заливка может быть применена 

только к замкнутому контуру. Замкнутый объект может быть залит цветом, 
узором или текстурой. 

Градиент – плавный переход одного цвета в другой. 
Пипетка – инструмент, применяемый для определения цвета уже нарисо-

ванного объекта. 
Маска – часть объекта с полупрозрачной заливкой. 
Цветовая модель – набор так называемых основных цветов, смешивая ко-

торые можно получить полный цветовой спектр. 
Цветовая палитра – это библиотека заранее определенных цветов. 
Свойства – параметры объекта. Например, толщина линии контура, цвет 

контура или заливки. 
Сегмент – участок контура между двумя узлами. 
Маркеры – черные прямоугольники, расположенные вокруг выделенного 

объекта. Маркеры предназначены для изменения размеров отдельного объекта. 
Узлы, или узловые точки – маленькие черные квадратики, которые нахо-

дятся на контуре объекта. 
Направляющие линии – вспомогательные линии, используемые для точного 

позиционирования объектов на рисунке. 
Привязка – функция, позволяющая быстро выровнять уже нарисованные 

объекты, например, относительно направляющих линий, узлов сетки или дру-
гих объектов. 

Выделение объектов – для выделения объекта воспользуйтесь инструмен-
том Pick (Указатель), а для выделения узла – инструментом Shape (Форма). 
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Выделение группы объектов – если необходимо выделить сразу несколько 
объектов или узлов, последовательно щелкните по каждому из них соответст-
вующим инструментом, нажимая и удерживая клавишу Shift. Также возможно 
выделение рамкой. Для этого, используя инструменты Pick или Shape, удержи-
вайте нажатой левую кнопку мыши и растяните вокруг объектов или узлов пря-
моугольную пунктирную рамку. 

Слой – псевдоповерхность, на которой размещаются объекты рисунка. 
Порядок наложения – объекты могут пересекаться, но располагаться при 

этом на разных слоях. Последовательность, в которой расположены объекты, 
называется порядком наложения. Первый объект находится позади всех, на 
заднем плане, а объект, нарисованный последним, – на переднем. 

Гpynna – группа объединенных вместе объектов, которые имеют те же 
свойства, что и отдельный объект. Их можно перемещать и изменять как объ-
ект. Группы объектов можно объединять во вложенные группы, которые также 
ведут как единый объект. Операция группировки выполняется с помощью ко-
манды Group (Группировать). 

Разгруппировка – для того чтобы объединенные группировкой объекты 
вновь преобразовать в отдельные объекты, существует обратная команда Un-
group (Разгруппировать). 

Преобразование в кривые – преобразование объекта в набор кривых. Часто 
используется перед просмотром или распечаткой рисунка на компьютерах с раз-
ной конфигурацией или набором компонентов CorelDRAW. Необходим также 
при редактировании таких простых фигур, как прямоугольник или окружность. 

Линза – специальное окно, которое позволяет имитировать различные эф-
фекты фотообъектива. 

2. Для оформления графического проекта потребуется знание приемов 
точного рисования, применение которых требует использования сетки, линеек 
и направляющих. Сетка представляет собой набор равномерно расположенных 
пересекающихся линий, служащих для привязки объектов. Линейки показыва-
ют положение указателя и размеры внутри рабочего поля. Направляющие – это 
линии, используемые для выравнивания или привязки объектов. Настройку 
элементов точного рисования можно осуществлять из присоединенного окна 
диспетчера объектов или с помощью команд меню View. 

3. Все векторные рисунки состоят из линий или контуров – основных эле-
ментов любого рисунка. В процессе работы над документом важными этапами 
являются рисование и редактирование линий. Для создания и работы с линиями 
предусмотрен ряд инструментов и функций: 

– базовые инструменты масштабирования (Zoom) и перетаскивания (Hand); 
– выделение узловых точек; 
– преобразование объектов в кривые; 
– работа с узлами кривых (инструмент Shape); 
– разрезание объектов (инструмент Knife); 
– ластик (инструмент Eraser); 
– размывающая кисть (инструмент Smudge Brush); 
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– грубая кисть (инструмент Roughen Brush); 
– удаление части кривой (функция Virtual segment delete); 
– произвольная линия (инструмент Freehand); 
– карандаш Безье (инструмент Bezier); 
– художественный карандаш (инструмент Artistic Media); 
– перо (инструмент Pen); 
– полилиния (инструмент Polyline); 
– кривая по трем точкам (инструмент 3 Point Curve); 
– соединительные линии (инструмент Interactive Connector); 
– размерные линии (инструмент Dimension); 
– распознавание нарисованной кривой (инструмент Smart Drawing). 
 

 
 

Рис. 1.5. Рабочее поле, менеджер объектов и пиктограммы инструментов 
 
4. Понятие узловых точек и сегментов – ключевое в работе с кривыми и 

контурами. Узлы появляются при выделении этих объектов инструментом 
Shape (рис. 1.6). Редактирование узлов и сегментов предоставляет наиболее 
широкие возможности по изменению формы линий и объектов. Если инстру-
ментом Shape щелкнуть по узлу, он будет выделен и станет черным, появятся 
одна или две контрольные точки и пунктирные линии (плечи), соединяющие 
их с узлом. Контрольные точки задают длину и форму криволинейного сегмен-
та контура, а касательные линии – плечи, которые показывают, какие кон-
трольные точки соответствуют выбранному узлу (рис. 1.7). Прямолинейная 
кривая не имеет контрольных точек. В CorelDRAW различают узлы трех типов: 

– острый узел (Cusp) применяется для создания острых участков на кри-
вой объекта. Плечи с разных сторон этого узла не лежат на одной прямой, сле-
довательно, два прилегающих криволинейных сегмента имеют различную кри-
визну с разных сторон узла, а кривая, проходящая через такой узел, изгибается 
под острым углом (рис. 1.8). Радиус кривизны и угол наклона касательной для 
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каждого сегмента можно регулировать независимо друг от друга изменением 
длины и угла наклона плеча, то есть перемещением контрольных точек; 

– гладкий узел (Smooth) предназначен для создания гладкой (Seamless) 
кривой. Обе контрольные точки и узел находятся на одной прямой (рис. 1.9), но 
длина плеч разная. Это говорит о том, что кривая с одной стороны узла может 
быть изогнута иначе, чем с другой. Перемещение одной контрольной точки при-
водит к соответствующему изменению кривизны криволинейного сегмента с од-
ной стороны контрольной точки. Длина другого плеча при этом не изменяется; 

– симметричный узел (Symmetrical) во многом похож на гладкий – кон-
трольные точки и узел лежат на одной прямой (рис. 1.10), однако плечи при 
этом узле имеют одинаковую длину. При перемещении одной контрольной 
точки вторая тоже сдвигается, то есть плечи всегда оказываются равными. Из-
менение положения контрольной точки приводит к соответствующему измене-
нию угла наклона плеча к кривой; 

 

   
 

Рис. 1.6. Узлы – неотъемлемая 
часть любого объекта 

 
Рис. 1.7. Если выбрать узел инст-
рументом Shape, на касательной 
линии появятся контрольные 

точки 

 
Рис. 1.8. Cusp-узел  
используется для соз-
дания острых узлов 

 
Для изменения типа узла используется инструмент Shape (Форма), распо-

ложенный в раскрывающемся списке Shape Edit Layout (Редактирование фи-
гуры). Сначала выделите редактируемый узел, затем нажмите правую кнопку 
мыши, после чего выберите нужный пункт в контекстном меню. 

5. Преобразование объекта в кривую. Данная операция предназначена для 
преобразования объектов, редактирование которых невозможно или затруднено 
обычными средствами программы (например, текст, окружность или прямо-
угольник). У преобразованных объектов легко изменять форму с помощью 
обыкновенного инструмента Shape. Иногда преобразование объекта в кривые 
может понадобиться для решения проблем, связанных с отсутствием текстовых 
шрифтов на другом компьютере. Для того чтобы установить, является ли вы-
бранный вами объект фигурой или состоит из кривых, служит строка состоя-
ния. Если это фигура или текст, редактор проинформирует вас в строке состоя-
ния о типе и расположении объекта. Для преобразования объекта в кривые 
выделите его инструментом Pick (Указатель). Примените к объекту команду 
Arrange ->Convert to Curves (Компоновка -> Преобразовать в кривые) или 
сразу щелкните по значку Convert to Curves на панели свойств (рис. 1.11). 
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Рис. 1.9. Для создания гладких кривых 
используйте Smooth-узел 

 
Рис. 1.10. У симметричного узла плечи имеют 

одну длину 
 
6. Редактирование узлов инструментом Shape подразумевает выполнение 

самых разнообразных операций, в том числе добавление новых и удаление не-
нужных узлов, преобразование прямых линий в кривые и наоборот, перемеще-
ние узлов и манипулирование с их контрольными точками и др. 

 

 
 

Рис. 1.11. Место значка Convert to Curves на панели свойств 
 
Все перечисленные операции выполняются посредством инструмента 

Shape, при доступе к которому на панели свойств (рис. 1.12) отображаются 
управляющие элементы (по порядку слева направо): 

– кнопка Add Node{s) [1] – создает узел в том месте, где был щелчок 
мышью; 

– кнопка Delete Node(s) [2] – удаляет выделенные узлы; 
– кнопка Join Two Nodes [3] – объединяет два узла в один; 
– кнопка Break Curve [4] – разрывает контур в выделенном узле; 
– кнопка Convert Curve to Line [5] – преобразует кривую, расположенную 

вблизи выделенного узла, в прямую линию; 
– кнопка Convert Line to Curve [6] – преобразует прямую линию рядом с 

выделенным узлом в кривую; 
– кнопка Маке Node а Cusp [7] – преобразует выделенный узел в узел 

заострения; 
– кнопка Маке Node Smooth [8] – преобразует выделенный узел в сглажен-

ный узел или узел растяжения; 
– кнопка Make Node Symmetrical [9] – преобразует выделенный узел в сим-

метричный; 
– кнопка Reverse Curve Direction [10] – изменяет направление формирова-

ния контура; 
– кнопка Extend Curve to Close [11] – соединяет два выделенных конце-

вых узла прямой линией; 
– кнопка Extract Subpath [12] – отделяет контур, содержащий выделенные 

узлы; 
– кнопка Auto-Close Curve [13] – автоматически замыкает концевые узлы 

прямой линией; 
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– кнопка Stretch and Scale Nodes [14] – устанавливает режим перемещения 
и масштабирования выделенных узлов; 

– кнопка Rotate and Skew Nodes [15] – позволяет поворачивать и наклонять 
выбранные узлы; 

– кнопка Align Nodes [16] – выравнивает выделенные узлы; 
– кнопка Horizontal Mirror Node [17] – позволяет отразить узлы горизон-

тально; 
– кнопка Vertical Mirror Node [18] – позволяет отразить узлы вертикально; 
– кнопка Elastic Mode [19] – включает режим эластичной кривой; 
– кнопка Select All Nodes [20] – одновременно выделяет все узлы; 
– ползунок Curve Smoothness [21] – регулирует уровень сглаживания кон-

тура рядом с невыделенным узлом. 
7. Изменение формы объектов инструментами Knife (Нож), Eraser (лас-

тик), Smudge Brush (Размывающая кисть), Roughen Brush (Грубая кисть), ис-
пользованием функции Virtual segment delete: 

а) инструмент Knife (Нож) отрезает часть контура объекта. Выполненные 
им разрезы могут быть как произвольной формы, так и прямыми. Инструмент 
находится на раскрывающейся панели Shape панели инструментов. Объект, 
разделяемый с помощью инструмента Knife, автоматически преобразуется в 
набор кривых. 

 

 
 

Рис. 1.12. Управляющие элементы панели свойств 
 
При работе с данным инструментом на панели свойств объекта доступны 

следующие управляющие элементы: 
– кнопка Leave As One Object – устанавливает режим сохранения единого 

объекта; 
– кнопка Auto-Close On Cut – позволяет задать режим автоматического 

замыкания при резании; 
б) инструмент Eraser (Ластик) позволяет выборочно удалять любые части 

объекта. При работе с этим инструментом доступны следующие управляющие 
элементы на панели свойств объекта: 

– текстовое поле Erase Thickness – задает толщину ластика; 
– кнопка Auto-Reduce On Erase – включает режим автоматического уда-

ления узлов на участках контура; 
– кнопка Circle/Square – позволяет выбрать круглый или квадратный ластик; 
в) инструмент Smudge Brush (Размывающая кисть) позволяет изменять 

контур объекта. Данный инструмент можно применять только к объектам, об-
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разованным из кривых (Curve). Назначение элементов управления на панели 
свойств объекта при работе с этим инструментом: 

– текстовое поле с переключателями Nib Size позволяет задать максималь-
ный размер профиля кисти; 

– кнопка Use stylus pressure setting открывает панель настройки электрон-
ного пера или электронного дигитайзера – дополнительных устройств, подклю-
чаемых к компьютеру; 

– текстовое поле Add Dry out to the effect задает коэффициент уменьше-
ния размера кисти в зависимости от расстояния, пройденного от контура; 

г) инструмент Roughen Brush (Грубая кисть) позволяет создавать зубцы на 
контуре кривой. Инструмент можно применить только к объектам, образован-
ным из линий произвольной формы (Curve). Параметры зубцов регулируются 
на панели свойств, которая имеет следующие управляющие элементы: 

– текстовое поле с переключателями Nib Size позволяет задать максималь-
ную высоту зубца; 

–  кнопка Use stylus pressure setting открывает панель настройки элек-
тронного пера или электронного дигитайзера – дополнительных устройств, 
подключаемых к компьютеру; 

– текстовое поле Enter а value for frequency of spikes задает количество 
зубцов; 

– текстовое поле Add Dry out to the effect задает коэффициент уменьше-
ния размера кисти в зависимости от расстояния, пройденного от контура; 

– текстовое поле Enter а fixed value for tilt setting задает угол наклона ин-
струмента к поверхности документа; 

– раскрывающийся список Spike Direction используется для выбора вари-
анта наклона зубьев: 

– Auto – симметричное расположение; 
– Fixed Direction – фиксированный угол наклона зубьев, задаваемый в тек-

стовом поле Enter а Fixed value for bearing; 
– текстовое поле Enter а fixed value for bearing setting задает угол ориен-

тации инструмента. 
д) Функция Virtual segment delete (Удалить виртуальный сегмент) позво-

ляет удалить часть какой-либо кривой или объекта. Инструмент не работает со 
связанными группами, такими как растровые рисунки, тени или текст. 

8. Инструмент Freehand служит для рисования произвольных линий. 
При этом способе рисования контур линии повторяет траекторию переме-

щения указателя мыши. Это самый простой инструмент для рисования, хотя не 
очень точный. Однако нарисованные с его помощью линии всегда можно 
улучшить, редактируя узлы инструментом Shape (Форма). 

9. Инструмент Bezier (Кривая Безье) используется для рисования гладких 
кривых при помощи последовательного задания узлов. По мере создания узлов 
можно управлять кривизной линии, манипулируя контрольными точками теку-
щего узла. Основное отличие линий, создаваемых инструментом Bezier, от ли-
ний, рисуемых Freehand, состоит в более высокой точности их формирования. 
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Дополнительной функцией также является возможность редактирования линии в 
процессе ее формирования. При выборе инструмента Bezier на панели свойств 
доступны те же настройки, что и при выборе инструмента Shape. 

Порядок рисования прямой линии: 
– выберите инструмент Bezier; 
– щелкните мышью в том месте, где будет располагаться первый узел. За-

тем выберите место, где будет находиться следующий узел, и щелкните там. 
Между двумя узлами появится участок прямой линии. Инструмент допускает 
последовательное создание прямолинейных участков, поэтому можно продол-
жить рисование прямолинейных участков, повторяя это действие до тех пор, 
пока не закончите рисование. 

– Для завершения рисования нажмите клавишу пробела или выберите дру-
гой инструмент. 

Если вы хотите нарисовать кривую линию произвольной формы: 
а) выберите инструмент Bezier и установите курсор мыши в том месте, от-

куда начнется кривая. Затем щелкните мышью и, удерживая нажатой кнопку, 
перетащите ее. Появится узел с двумя контрольными точками, которые растя-
гиваются в противоположных направлениях по мере перетаскивания мыши; 

б) отпустите кнопку мыши, когда контрольные точки окажутся на нужном 
расстоянии от узла. Расстояние между узлом и контрольными точками опреде-
ляет кривизну сегмента линии. Чем дальше отстоят контрольные точки от узла, 
тем больше кривая будет выгибаться в направлении соединяющей их прямой; 

в) установите указатель в той точке, где вам необходим второй узел; 
г) щелкните мышью и перетащите ее, чтобы создать узел с двумя кон-

трольными точками. Между двумя узлами появится сегмент кривой линии; 
д) чтобы продолжить рисовать кривую, повторите шаги в) и г). Если необ-

ходимо создать замкнутый контур, щелкните последний раз точно по верху ис-
ходного узла, чтобы конечная и начальная точки кривой совпали; 

е) когда рисование будет закончено, нажмите клавишу пробела или выбе-
рите другой инструмент. 

10. Художественная кисть. В основе инструмента Artistic Media лежит 
принцип нанесения различных изображений вдоль нарисованного контура. При 
помощи этого инструмента можно рисовать линии с переменной толщиной и из-
меняющейся формой, закрашивать их кистью или распылителем, а также созда-
вать каллиграфические линии. Группа этого инструмента фактически состоит из 
пяти отдельных инструментов: Preset (По образцу), Brush (Кисть), Sprayer (Рас-
пылитель), Calligraphic (Каллиграфия), Pressure (С нажимом). Чтобы восполь-
зоваться каким-нибудь инструментом, выберите его в раскрывающейся панели 
Curve либо щелкните по одному из значков на панели свойств. 

11. Инструмент Реn во многом напоминает рассмотренный выше инстру-
мент Bezier (Безье). Однако возможности его существенно шире. Во-первых, он 
позволяет добавлять и удалять промежуточные узлы, а во-вторых, используется 
для отображения будущего сегмента образующего контура создаваемой линии. 
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На панели свойств инструмента Реn помимо элементов, предусмотренных для 
инструмента FreeHand, есть также два дополнительных: 

– кнопка Preview Mode – задает режим отображения будущего сегмента кон-
тура линии, который будет реализован щелчком мыши в текущем месте указателя; 

– кнопка Auto Add-Delete – включает режим добавления и удаления узлов 
к контуру линии. 

Порядок рисования прямых и кривых линий инструментом Pen практиче-
ски повторяет алгоритм построения кривых при помощи инструмента Bezier. 

12. Инструмент Polyline (Полилиния) предназначен для рисования произ-
вольных линий, как прямых, так и кривых. Средство сравнимо с инструментом 
Freehand, но обеспечивает дополнительные возможности. В частности, инстру-
мент позволяет рисовать прямолинейные участки линии с помощью щелчков 
мыши. Панель свойств инструмента Polyline такая же, как и у средства Freehand. 

Чтобы воспользоваться инструментом Polyline: 
1) выберите инструмент Polyline в раскрывающейся панели Curve; 
2) если будущий участок линии будет криволинейным, то его формирова-

ние следует осуществлять при нажатой кнопке мыши; 
3) если предполагаемый участок линии будет прямолинейным, то формиро-

вание следует выполнять последовательными щелчками левой кнопкой мыши; 
4) чтобы закончить рисование, нажмите клавишу пробела, дважды щелк-

ните мышью или совместите конечную точку кривой с начальной точкой (дол-
жен получиться замкнутый контур). 

13. Инструмент 3 Point Curve (Кривая по трем точкам) предназначен для 
создания кривых, состоящих из двух узлов. Панель свойств инструмента Poly-
line такая же, как у средства Freehand. 

Создание линий и кривых – это только начальный этап рисования. Для 
придания выразительности и завершенности объектам очень важно правильно 
настроить параметры создаваемых линий. Такая процедура настройки парамет-
ров линий называется обводкой контуров. Выбор параметров обводки в пер-
вую очередь зависит от решаемых пользователем задач. Далее перечислим 
кратко приемы создания и параметры настройки различных стилей обводки: 

– параметры обводки контуров; 
– раскрывающаяся панель Outline; 
– диалоговое окно Outline Pen; 
– стили линий; 
– наконечники; 
– концы и углы; 
– каллиграфические линии; 
– разделение обводки и объекта. 
14. Обводку можно отделить от объекта, после чего работать с ней, как с 

отдельным объектом. Для этого: 
1) выделите объект инструментом Pick (Выбор); 
2) выполните команду меню Arrange ->Convert Outline То Object (Компо-

новка ->Преобразовать обводку в объект); 
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3) При помощи инструмента Pick выделите обводку и перетащите ее в 
другое место рабочего окна. 

Для полноценной работы в CorelDRAW 12 кроме рисования необходимо 
изучить основные операции и приемы работы с объектами. Наряду с интуитив-
но понятными способами преобразования объектов редактор поддерживает и 
специальные методы, обеспечивающие высокий уровень индивидуальности и 
точности, которые обеспечиваются следующими операциями и инструментами: 

– выделение объектов и работа с инструментом Pick; 
– перемещение объектов; 
– копирование, дублирование, клонирование и удаление объектов; 
– изменение размеров объекта; 
– группировка и разгруппирование объектов; 
– блокировка объектов; 
– комбинирование объектов; 
– разделение объектов; 
– формирование объектов; 
– точные преобразования или трансформация объектов; 
– свободное преобразование и инструмент Free Transform Tool. 
15. Комбинирование объектов. При применении этого приема к выделенным 

перекрывающимся объектам формируется новый объект, в котором удаляются все 
перекрывающиеся области, образуя вырезы, сквозь которые видно, что находится 
под скомбинированным объектом. Заливка скомбинированного объекта использу-
ет цвет заливки самого нижнего из исходных объектов (рис. 1.13). Для выполне-
ния комбинирования выделенных объектов выполните команду меню Arrange -> 
Combine (Компоновка -> Комбинировать) или нажмите клавиши Ctrl+L. 

16. При разделении сложных объектов, состоящих из нескольких отдельных 
объектов, или кривых используется операция разделения. Для выполнения разде-
ления скомбинированных выделенных объектов выполните команду меню  
Arrange->Break Apart (Компоновка->Разъединить) или нажмите клавиши 
Ctrl+K. Объекты примут свою исходную форму, и теперь можно работать с каж-
дым объектом отдельно. Если кривые выделить, в меню Arrange станет доступ-
ной команда Break Curve Apart (Разъединить кривую) аналогичного действия. 

17. Формирование объектов. Формированием объектов называются стан-
дартные операции для создания нового объекта в результате некоторых преоб-
разований группы объектов. К этим операциям относят: слияние (Weld), выре-
зание (Trim), пересечение (Intersect), упрощение (Simplify), вычитание 
объектов (Front Minus Back и Back Minus Front). Эти операции доступны в 
закрепленном  окне  Shaping (Формирование), которое  вызывается  командой 
Arrange -> Shaping-> Shaping (Компоновка -> Формирование -> Формирование). 

18. Операция слияния объектов. Слияние объектов используется для объеди-
нения нескольких объектов в один, с такими же внешними границами, как и ис-
ходные объекты, но с цветом заливки самого нижнего из них (см. рис. 1.13–1.14). 
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Рис. 1.13. Три перекрывающихся объекта 

 
Рис. 1.14. Результат слияния трех 
пересекающихся объектов 

 
Для эффективной и профессиональной работы с редактором необходимо 

умение применять следующие приемы: диспетчер объектов, работу со слоями, 
порядок наложения, виды. Грамотное владение этими средствами способно 
значительно сократить время на выполнение второстепенных операций и сде-
лать работу максимально комфортной.  

19. Слои – это невидимые, наложенные друг на друга плоскости, которые 
позволяют размещать определенные элементы по отдельности. Пользоваться 
слоями очень удобно при создании и последующем редактировании текста и 
графики в сложных по своей структуре и организации проектах. Например, при 
работе с каталогом можно расположить текстовые и растровые объекты в двух 
отдельных слоях, а при последующем редактировании – только в одном слое. 

По умолчанию все объекты находятся каждый в отдельном слое. Чтобы оп-
ределить, к какому слою относится тот или иной объект, используйте информа-
цию строки состояния. Для работы со слоями используется закрепленное окно 
Object Manager (Диспетчер объектов), которое открывается после выполнения 
команды меню Window > Dockers -> Object Manager (Окно -> Закрепленные 
окна -> Диспетчер объектов) или Tools -> Object Manager (Инструменты -> 
Диспетчер объектов). Диспетчер объектов позволяет управлять отображением 
объектов, выводом их на печать, а также выполняет другие функции. 

20. В каждом отдельном слое может находиться любое количество объек-
тов различных типов, располагаемых в определенном порядке наложения в 
зависимости от последовательности их создания. Порядок наложения и слои – 
совершенно разные понятия. Для изменения порядка наложения совсем не обя-
зательно создавать и менять слои. 

 
1.5. Упражнения по созданию объектов векторного изображения 
с использованием инструментов графического редактора 

 
Выполнить следующие упражнения: 
1. Использовать кривые Безье для рисования симметричных криволиней-

ных объектов, представляющих следующие образы: сердце; листья березы, 
клена, виньетки, елка, грибок, солнце с лучами. 
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2.  Освоить инструмент Художественная кисть для создания оформи-
тельских декоративных элементов изображений: рамок, растительного орна-
мента, отдельных объектов. 

3. Освоить инструменты Грубая кисть и Размывающая кисть на образ-
ах деревьев и животных. 

4. Для раскраски графических образов использовать градиентные заливки. 
 
 

Лабораторная работа №2 
 

Разработка графических проектов с использованием редактора 
векторной графики CorelDRAW Suite 12 

 
Цель работы: 
1. Освоить работу с цветом в программе CorelDRAW: 
а) цвет и заливки. Цветовые модели. Палитры, используемые в CorelDRAW. 

Создание собственной палитры; 
б) понятие заливки. Однородная заливка. Градиентная заливка. Типы гра-

диентных заливок. Опции градиентной заливки. Узорчатые заливки: двухцвет-
ные, полноцветные, растровые. Текстурные заливки. Создание собственного 
узора; 

в) контурный абрис объекта. Цвет контура объекта; 
г) цветовые стили. Автоматическое и ручное создание цветовых стилей. 
2. Освоить работу с текстом в программе CorelDRAW 
а) простой текст. Редактирование текста. Фигурный текст. Переключение 

типов текста. Изменение размера, толщины шрифта. Выбор типа выравнивания. 
Настройка интервалов. Кернинг отдельных символов. Форматирование отдель-
ных символов; 

б) эффекты при работе с текстом: обтекание, размещение текста вдоль кри-
вой, создание рельефного текста, хромированного, прозрачного. Создание тек-
стовой маски; 

3. Освоить применение эффектов в программе CorelDRAW: 
а) добавление перспективы. Редактирование перспективы; 
б) оболочки. Создание изгибающих оболочек. Режимы изгибания. Фигур-

ный текст в оболочке. Простой текст в оболочке.  
в) перетекание объектов. Использование пути при перетекании. Имитация 

цветового перехода; 
г) экструзии. Типы экструзии: с сужением и удалением, с сужением и при-

ближением, с расширением и удалением, с расширением и приближением, с 
удалением, с приближением; 

д) фаски. Контуры. Создание специальных эффектов путем добавления 
контуров. Эффекты линзы, прозрачности и тени. Настройка и редактирование 
эффектов. Фигурная обрезка объектов (Power Clip). 
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Компьютерные цветовые модели 
 

Цвет как составная часть изображения выполняет сразу две важные функ-
ции: он является средством кодирования информации об изображаемом пред-
мете и средством воздействия на ассоциативную память зрителя, призванным 
вызывать у него определенные эмоции. Физически в основе цвета лежит волно-
вая природа электромагнитных колебаний высокой частоты – света. Световые 
волны разной длины по-разному воздействуют на сетчатку человеческого глаза. 
Инфракрасные волны (колебания с длиной волны больше, чем у красного цве-
та) и ультрафиолетовые волны (колебания с длиной волны меньше, чем у фио-
летового цвета) сетчаткой не воспринимаются. 

Дневной свет, субъективно воспринимающийся как лишенный цветовой со-
ставляющей, в физическом смысле представляет собой смесь колебаний всех 
частот (не только оптического, но и смежных диапазонов). В силу физиологии 
органов зрения цветовосприятие – субъективный процесс, и его характеристики 
во многом определяются индивидуальными особенностями человека. Даже у 
людей с нормальным цветовосприятием диапазоны волн, соответствующие цве-
там, немного различаются, не говоря уже о цветоаномалах (людях с существен-
ными смещениями таких диапазонов) и дальтониках (людях, страдающих цвето-
вой слепотой). Несмотря на это, во многих областях человеческой деятельности 
необходимы способы объективного описания цвета, не зависящего от индивиду-
альных особенностей цветовосприятия (в частности, в полиграфии и компьютер-
ной графике). Такие способы описания цвета в виде совокупности числовых па-
раметров называются компьютерными цветовыми моделями. 

Перед описанием собственно цветовых моделей рассмотрим два способа, 
которыми свет может попадать на сетчатку глаза зрителя, и то влияние, которое 
эти способы оказывают на природу образования цвета. 

Излученный и отраженный свет. В темной комнате прекрасно видно все, 
что отображается на экране монитора, но не видно ничего, что отпечатано прин-
тером на листе бумаги. Причина очевидна: монитор является источником света, 
он излучает электромагнитные волны оптического диапазона. Лист бумаги, с 
изображением или без него, света не излучает. Он лишь отражает электромаг-
нитные волны оптического диапазона, излученные внешним источником света. 

Механизмы образования цвета при попадании в глаз зрителя излученного 
света и отраженного света сильно отличаются друг от друга. Когда зритель 
смотрит на источник света, на сетчатку его глаз попадают волны оптического 
диапазона всех частот, излучаемых источником, и в тех пропорциях, в которых 
он их излучает. В физике присутствие в излучении различных частот (в том 
числе оптического диапазона) и вклад каждой из них в общую энергию излуче-
ния описывается спектральной диаграммой. При восприятии зрителем излучен-
ного света спектральная диаграмма излучения, воздействующего на сетчатку 
человеческого глаза, не отличается от спектральной диаграммы источника све-
та. Итак, глядя на источник света, зритель видит тот цвет, который этот источ-
ник излучает. 
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Другое дело, когда зритель смотрит на объект, не излучающий света. Если 
на такой объект не падает свет внешнего источника, зритель его просто не ви-
дит. Если на объект попадает свет, то часть его, отражаясь от объекта, попадает 
в глаза зрителя. В процессе отражения часть волн падающего на объект света 
может поглощаться им, поэтому до глаза зрителя доходят не все волны, излу-
ченные источником. Изменение состава света при отражении вызывает измене-
ние цветового восприятия. Субъективно это выглядит как наличие того или 
иного цвета у отражающего объекта. Фундаментальные различия механизмов 
образования цвета излученным и отраженным светом приводят к необходи-
мости применения различных цветовых моделей. Преобразование представле-
ния цветов изображения при переходе от одной цветовой модели к другой мо-
жет привести к искажению цветов. Чтобы этого не происходило, необходимо 
четко представлять устройство цветовых моделей, использующихся в програм-
мах компьютерной графики. 

Ахроматические модели. Из приведенного описания природы цвета сле-
дует, что белый цвет соответствует равномерной смеси частот электромагнит-
ных колебаний оптического диапазона, а черный – отсутствию света. Для опи-
сания изображений, содержащих пикселы только этих двух цветов, а также 
промежуточных оттенков серого цвета (равномерная смесь частот оптического 
диапазона с пониженной энергией по сравнению с белым цветом) используются 
две ахроматические (не включающие цвета) модели. Их важность в компью-
терной графике обусловлена тем, что ахроматические изображения очень рас-
пространены и с ними приходится работать довольно часто. Ахроматическими 
являются штриховые и монохромные изображения. 

Штриховым называется точечное изображение, каждый из пикселов ко-
торого может быть только одного из двух цветов, первый называется фоновым 
(чаще всего белый), второй называется цветом переднего плана (чаще всего 
черный). В традиционной графике таким изображениям соответствуют рисунки 
пером, гравюры, офорты. Для описания цвета каждого из пикселов штрихового 
изображения достаточно сопоставить ему дескриптор, состоящий из одного би-
та. Значение такого дескриптора может равняться единице или нулю. Цветовая 
модель штрихового изображения наиболее компактна – при одинаковых разме-
рах изображения в пикселах и размерах самих пикселов она занимает наимень-
ший объем памяти по сравнению с другими моделями. 

Несмотря на простоту представления, ахроматические модели играют очень 
значительную роль в компьютерной графике. Фоновый цвет (обычно белый) и 
цвет переднего плана (обычно черный) в этой модели могут быть с успехом за-
менены любыми другими (на этом основаны многие приемы компьютерной гра-
фики). При этом ни сущность модели, ни приемы работы с ней не меняются. 

Монохромное изображение отличается от штрихового тем, что составляю-
щие его пикселы могут быть любого из оттенков, составленных смешиванием 
двух базовых цветов. Оттенком называется смесь базовых цветов модели в фик-
сированной пропорции. Оттенки отличаются друг от друга процентным содер-
жанием в них базового цвета. Например, в 20-процентном оттенке монохромати-
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ческой модели с красным и белым базовыми цветами содержится 20 % красного 
и 80 % белого цвета. Если в качестве базовых цветов используются черный и бе-
лый цвета, принято говорить о шкале градаций серого цвета. 

Ахроматические фотографии, которые традиционно называются черно-
белыми, фактически являются монохромными. Не всегда в качестве базовых цве-
тов фотографической монохромной шкалы градаций используются черный и бе-
лый цвета. В зависимости от технологии последующего воспроизведения изобра-
жения монохромная модель предоставляет пользователю возможность выбирать 
из 100 или 256 оттенков базового цвета. Следовательно, дескриптор пиксела мо-
нохромного изображения представляет собой число, которое может принимать 
значения от 0 до 255. Такое число можно разместить в памяти размером 1 байт.  

Суммарное количество двоичных разрядов, которые отводятся в памяти 
компьютера для представления информации о цвете одного пиксела информаци-
онной модели, принято называть цветовой разрешающей способностью, или 
битовой глубиной цвета. Цветовая разрешающая способность измеряется в би-
тах на пиксел (bit per pixel, bpp). Если речь идет о монохромном изображении, 
дескриптор пиксела которого содержит 8 бит информации о цвете, то цветовая 
разрешающая способность такой модели равна 8 bpp, что позволяет получить 
256 оттенков. Цветовая разрешающая способность имеет смысл даже для штри-
хового изображения. При использовании этой цветовой модели она равна 1 bpp. 

Монохромные изображения играют очень важную роль в компьютерной 
графике и полиграфии. Это обусловлено тем, что именно монохромные изобра-
жения лежат в основе полиграфического процесса цветовой печати, так как при 
подготовке изображения к цветной печати приходится выполнять процедуру 
цветоделения. В результате этой процедуры исходное цветное изображение раз-
деляется на монохромные изображения с различными базовыми цветами, кото-
рые при печати накладываются друг на друга.  

К монохромным изображениям вплотную примыкают дуплексы. Дуплек-
сом называется комбинация двух монохромных изображений, совмещенных 
при выводе. В большинстве графических программ этот термин имеет немного 
другое значение – под дуплексом подразумевается монохромное изображение, 
в котором часть оттенков базового цвета заменяется оттенками другого базово-
го цвета или даже несколькими другими цветами. 

В зависимости от общего числа цветов, использующихся при воспроизве-
дении изображения, различают следующие разновидности дуплексов: двухкра-
сочный (duotone), трехкрасочный (tritone) и четырехкрасочный (quadrotone). 
Однокрасочные дуплексы (monotone) фактически представляют собой исходное 
монохромное изображение с заменой базового цвета.  

Модель индексированного цвета применяется в тех случаях, когда заранее 
известны все возможные цвета, которые могут встретиться в изображении, – все 
используемые в ней цвета и оттенки определены заранее, как у набора цветных 
карандашей или фломастеров. Основным элементом этой цветовой модели яв-
ляется палитра. Палитрой называется цветовая таблица, сопоставляющая фик-
сированным образцам цвета порядковые номера в виде натуральных чисел. Со-
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поставление номеров цветам выполняется с помощью цветовой модели RGB. 
Как правило, в палитру также включают черный и белый цвета, одно значение 
индекса цвета резервируют для прозрачности. Прозрачность пиксела при выво-
де осуществляется показом на его месте цвета фонового изображения. Кроме 
палитры в информационную модель изображения с индексированным цветом 
входят дескрипторы пикселов изображения, в каждом из которых хранится 
число – индекс сопоставленного каждому пикселу цвета, входящего в состав 
палитры. Ранние модели персональных компьютеров позволяли работать толь-
ко с моделями индексированного цвета, причем цветовая разрешающая способ-
ность составляла всего 4 bрр. В использующихся сегодня моделях индексиро-
ванного цвета цветовая таблица (размер палитры) не превышает 256, 
следовательно, цветовая разрешающая способность такой информационной 
модели равна 8 bрр. 

В пиксельном изображении с индексированным цветом могут одновремен-
но присутствовать не более 255 цветов, тем не менее, в изображении визуально 
может восприниматься присутствие значительно большего числа оттенков. Это 
достигается за счет имитации (dithering) – специального приема, основанного на 
феномене смыкания. В данном случае смыкание проявляется в том, что смежные 
пикселы изображения, окрашенные в цвета, присутствующие в палитре, зри-
тельно воспринимаются как более крупное пятно, окрашенное в смешанный 
цвет, который в палитре может и отсутствовать. Модели с индексированными 
цветами по-прежнему используются в Интернете, но из экранных приложений 
(мультимедийных презентаций, компьютерных игр, тренажеров) их практически 
полностью вытеснили более совершенные модели представления цвета. 
 

2.1. Модель RGB 
 
Название модели RGB представляет собой аббревиатуру, составленную из 

начальных букв английских слов Red (Красный), Green (Зеленый) и Blue (Си-
ний). Эти слова соответствуют трем базовым цветам модели излучаемого цвета. 

Выбор именно этих базовых цветов обусловлен физиологией человеческо-
го зрения, непосредственно воспринимающего только эти цвета. Все остальные 
цвета в этой модели образуются за счет смешения базовых цветов в различных 
пропорциях. Это смешение при рассматривании происходит в результате смы-
кания в глазу зрителя изображений, близко расположенных друг к другу трех 
источников света, имеющих небольшие поперечные размеры. 

Тройки смежных источников излучают свет базовых цветов модели. Регу-
лировка пропорций, в которых смешиваются базовые цвета, выполняется за счет 
изменения интенсивности излучения источников. Именно так работает цветная 
электронно-лучевая трубка, лежащая в основе компьютерных мониторов.  

Другое название модели RGB – аддитивная, от слова add (складывать). При 
сложении (смешении) базовых цветов модели получившийся цвет становится бо-
лее светлым (чем интенсивней свет, тем светлее) и за счет смыкания образует но-
вый цветовой оттенок. Смешение красного и зеленого в равных пропорциях дает 
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оттенки монохроматической шкалы с желтым и белым базовыми цветами, зелено-
го и синего – оттенки голубого, синего и красного – оттенки пурпурного. Смеше-
ние трех базовых цветов в равных пропорциях дает оттенки монохроматической 
шкалы серого цвета, в неравных пропорциях – хроматические оттенки. 

Три параметра аддитивной цветовой модели, описывающие интенсивность 
излучения базовых цветов модели, могут принимать значения от 0 до 256. Сле-
довательно, для их хранения в памяти достаточно 3 байта, или 24 бита. Поэтому 
цветовая разрешающая способность аддитивной модели составляет 24 bрр. 
Цветовое пространство (совокупность всех цветов) модели RGB может быть 
представлено в виде куба, на гранях которого и внутри него расположены все 
цвета, которые можно воспроизвести в рамках этой цветовой модели (рис. 2.1). 

Характерные точки и линии этой модели. Точка в начале координат со-
ответствует черному цвету. Наиболее удаленная точка от начала координат со-
ответствует максимальной интенсивности излучения всех трех источников и, 
следовательно, белому цвету. Эти две точки соединяет диагональ куба, соот-
ветствующая монохромной шкале оттенков серого цвета. Три вершины куба, 
лежащие на осях координат, соответствуют базовым цветам аддитивной моде-
ли, остальные три – дополнительным цветам этой модели. Дополнительные 
цвета аддитивной модели образованы попарным смешением базовых цветов в 
равных пропорциях. Диагонали и ребра куба, проходящие через точку белого 
цвета, соответствуют монохромным шкалам оттенков хроматических цветов – 
основных (диагонали) и дополнительных (ребра). 

Проекция вершин куба аддитивной цветовой модели на плоскость в на-
правлении линии, соответствующей монохромной шкале оттенков серого цве-
та, образует часто используемую абстракцию – так называемый цветовой круг. 
Он представлен на рис. 2.2. 

Особенности данного цветового круга по сравнению с кругом на рис. 1.2: 
последовательность цветов в нем соответствует спектральной, а базовые (основ-
ные) цвета аддитивной модели расположены напротив дополнительных (ком-
плементарных к ним). Комплементарными, или взаимно дополняющими, на-
зывается пара цветов, располагающихся на цветовом круге напротив друг друга. 
Это название объясняется тем, что при смешении комплементарных цветов в 
равных пропорциях получается оттенок монохромной шкалы серого цвета. 

Важность аддитивной цветовой модели в художественной компьютерной 
графике невозможно переоценить. Достаточно отметить, что именно с приме-
нением этой модели кодируется цвет в сканированных изображениях, и эта же 
модель используется при воспроизведении изображений на экране монитора. 
 

2.2. Модели CMYK, HSB, HSL 
 
Название модели CMYK дала аббревиатура, составленная из начальных букв 

английских слов Cyan (Голубой), Magenta (Пурпурный), Yellow (Желтый) и ко-
нечной буквы слова Black (Черный). Модель CMYK – цветовая модель для всех 
случаев, когда мы имеем дело с отраженным светом. Как уже отмечалось ранее, в 
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этих случаях наложенные на лист бумаги полупрозрачные краски при прохожде-
нии через них света вычитают из него отдельные спектральные компоненты. Эта 
особенность определила другое название модели – субтрактивная, от слова sub-
tract (вычитать). Базовые цвета цветовой модели CMYK часто называют также 
субтрактивными, или триадными (цветами полиграфической триады). 

Выбор хроматических базовых цветов субтрактивной модели объясняется 
природой цветообразования отраженным светом. Краски этих цветов поглоща-
ют, соответственно, красную, зеленую и синюю спектральные составляющие от-
раженного света, позволяя тем самым репродуцировать на бумаге большую 
часть цветового спектра. Каждый из трех хроматических параметров субтрак-
тивной цветовой модели соответствует процентному содержанию в пикселе на-
печатанного на бумаге точечного изображения соответствующей ему базовой 
краски. При увеличении процентного содержания базовых цветовых компонен-
тов изображение на бумаге становится темнее (чем больше на лист положено 
краски, тем больше ею поглощается света). Теоретически, при смешении макси-
мального допустимого количества (установленного этой моделью) всех трех 
хроматических компонентов должен получаться черный цвет, а при отсутствии 
хроматических красок – белый цвет (чистый лист бумаги). Смешение хромати-
ческих компонентов в равных пропорциях соответствует оттенкам серого цвета 
(монохромная шкала с базовым черным цветом). При схематическом изображе-
нии цветового пространства субтрактивной модели получается схема (рис. 2.3). 

К сожалению, на практике не удается добиться удовлетворительного вос-
произведения черного цвета только с помощью хроматических компонентов 
субтрактивной модели. При реальном смешивании (100 % желтой, 100 % пур-
пурной и 100 % голубой) полиграфических красок вместо черного цвета получа-
ется грязноватый темный оттенок коричневого цвета. Наблюдается также хрома-
тическая «засоренность» оттенков серого цвета на протяжении всей 
монохромной шкалы серого. 

Чтобы компенсировать этот недостаток субтрактивной модели, в нее был 
добавлен еще один базовый цвет – черный. Это привело к добавлению еще одно-
го параметра в состав дескрипторов цветовой модели – в субтрактивной цвето-
вой модели их четыре. В некоторых случаях черный цвет в цветном изображе-
нии, напечатанном на бумаге, воспроизводится за счет смешения 
ахроматических и хроматических компонентов. Полученный таким образом (с 
применением хроматической добавки) черный цвет принято называть обогащен-
ным черным. Четыре параметра субтрактивной цветовой модели, описывающие 
количество краски базовых цветов модели в пикселе изображения, могут прини-
мать значения от 0 до 100. Для их хранения в памяти достаточно 28 бит. Поэтому 
цветовая разрешающая способность аддитивной модели составляет 28 bрр. На 
практике для хранения каждого числа отводится не 7 бит, а 1 байт (8 бит), по-
этому принято считать, что у субтрактивной цветовой модели цветовая разре-
шающая способность равна 32 bрр. 

В полиграфии пользуются плашечными цветами. Технология плашечного 
цвета означает нанесение на образец сплошного пятна непрозрачной краски. 
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Краски для плашечной печати выпускаются либо в виде комплектов, готовых к 
употреблению, либо смешиваются из базовых красок непосредственно в типо-
графии перед заправкой в печатные машины. За счет того, что цветовой тон оп-
ределяется заранее подготовленной краской, применение плашечных цветов 
позволяет добиться довольно высокой точности воспроизведения цвета. 

 

 
 

 
Рис. 2.1. Цветовая модель RGB 

 
Рис. 2.2. Цветовой 

круг 

 
Рис. 2.3. Цветовая модель СMYK 

 
Наборы стандартных красок и рецептур смешивания базовых красок для 

получения плашечных цветов стандартизованы. Наиболее распространена стан-
дартизованная система Pantone Matching System (PMS). Часто такие каталоги 
выполняются в виде узких закладок, стопка которых скрепляется на одном 
конце или в середине, образуя некое подобие веера. Максимальное число пла-
шечных цветов, которые можно использовать в одном проекте, определяется 
техническими возможностями печатной машины и всегда очень невелико (на 
практике – не более шести). 

Модели HSB и HSL  построены с использованием рассмотренной ранее 
абстракции цветового круга (см. рис. 2.2). Управляющие параметры модели 
HSB соответствуют цветовому тону (hue), насыщенности (saturation) и яркости 
(brightness), а название модели представляет собой аббревиатуру, составленную 
из начальных букв соответствующих английских слов. 

Цветовой тон определяется угловой координатой, меняющейся от 0 до 
360°. Началом отсчета принят радиус цветового круга, направленный верти-
кально вверх (то есть 0° – красный цвет, 60° – желтый, 180° – голубой). 

Под насыщенностью понимается величина, обратно пропорциональная 
количеству белой краски, добавленной к чистому цветовому тону. Если белая 
краска не добавляется, насыщенность цвета равна 100 %. При насыщенности 
50 % половина цветового тона заменяется белым цветом, а при 0 % получается 
чистый белый цвет. Таким образом, изменение насыщенности при неизменной 
величине цветового тона дает все возможные оттенки монохромной шкалы. 
Уменьшение насыщенности соответствует «разбеливанию» цвета. 

Под яркостью понимается величина, обратно пропорциональная количе-
ству черной краски, добавленной к цветовому тону. Цвета цветового круга об-
ладают максимальной яркостью 100 %. Яркость 50 % означает, что половина 

Green 
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цветового тона (с учетом «разбеливания») замещается черным цветом. Яркость 
0 % означает черный цвет.  

Геометрическим аналогом пространства цветов модели HSB может служить 
цилиндр, у основания которого лежит черный круг. А верхнее основание пред-
ставляет собой круг, по кромке которого расположены все цвета цветового круга 
с максимальной насыщенностью 100 %. По мере смещения к центру верхнего 
основания цветовой тон заменяется белым цветом, и в центре получается чистый 
белый цвет. Любой точке верхнего основания цилиндра соответствует макси-
мальная яркость – 100 %. По мере смещения вниз вдоль оси цилиндра яркость 
уменьшается, и в любой точке нижнего основания она равна нулю. При относи-
тельной простоте и естественности восприятия модели HSB художником ее 
широкому распространению в компьютерной графике препятствует существен-
ный недостаток. Это необходимость преобразования в модель RGB для ото-
бражения на экране и в модель CMYK для вывода на печать, а любое преобра-
зование изображения из одной модели в другую приводит к снижению 
точности воспроизведения цвета. Тем не менее, многие программы компьютер-
ной графики позволяют работать с моделью HSB. 

Еще один недостаток модели HSB состоит в неудобстве визуального вос-
приятия ее третьего компонента – яркости. Оттенки различных хроматических 
цветов, имеющие равные значения этого параметра (например желтый и крас-
ный), визуально воспринимаются разными по яркости. Для устранения этого 
недостатка было введено понятие светлость. Под светлостью (lightness) пони-
мается параметр цветовой модели, позволяющий визуально сравнивать степень 
яркости цветового тона. Оттенки с равным значением этого параметра выглядят 
одинаково яркими. Модификация цветовой модели HSB, в которой яркость в 
качестве третьего параметра заменена светлотой, получила название HSL и до-
вольно широко используется в программах компьютерной графики. 

 
2.3. Модель L*a*b. Цветовой охват 

 
Цветовая модель L*a*b так же, как и предыдущая, имеет три параметра 

для описания цвета, но, в отличие от нее, разрабатывалась специально как ап-
паратно-независимая, то есть определяющая цвета без учета особенностей тех-
нологии цветовоспроизведения (на мониторе, принтере, печатной машине). 

В этой модели состав цвета определяется светлотой (luminosity) и двумя 
хроматическими параметрами. Первый из них (условно обозначенный латин-
ской буквой а) определяет соотношение зеленой и красной составляющих цве-
та, второй (обозначенный буквой b) – соотношение синей и желтой составляю-
щих (рис. 2.4). Модель L*a*b довольно широко используется в программах 
компьютерной графики в качестве промежуточной цветовой модели при вза-
имном преобразовании других цветовых моделей. Кроме того, стандарт языка 
PostScript Level 2 для представления файлов, отправляемых на печать, предпо-
лагает непосредственную интерпретацию цвета, представленного с помощью 
этой модели, процессором печатающего устройства. 
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Цветовым охватом (gamut) принято называть всю совокупность цветов, 
которые могут быть воспроизведены с использованием той или иной цветовой 
модели. Можно говорить также о цветовом охвате устройств, способных вос-
производить или воспринимать цвет: цветного принтера, сканера, человеческо-
го глаза. В окружающем нас мире цветовой охват практически безграничен, и 
то, какие цвета мы видим, а какие – нет, зависит только от физиологии челове-
ческого зрения. Только часть цветов, встречающихся в природных объектах и 
воспринимающихся человеческим зрением, можно воспроизвести, например, на 
экране монитора. Эта часть и составляет цветовой охват пары, составленной из 
монитора конкретной марки и цветовой модели RGB.  

 

 
 

Рис. 2.4. Схема представления 
цветовой модели L*a*b 

Рис. 2.5. Схема представления 
цветовых охватов цветовых моделей 

 
Цветовой охват полиграфического процесса ýже, чем цветовой охват мо-

нитора. Кроме принципиальных ограничений цветовой модели CMYK на его 
состав существенное влияние оказывают сорта используемой бумаги, качество 
полиграфического оборудования и красок. Принципиальные ограничения цве-
товой модели CMYK приводят к тому, что цветовой охват полиграфического 
процесса не совпадает с цветовым охватом монитора. В частности, на печати 
практически невозможно воспроизвести цвета, хроматические составляющие 
которых имеют малую плотность (оттенки менее 5 %). 

Наиболее широк цветовой охват у человеческого зрения, примерно совпа-
дает с ним цветовой охват аппаратно-независимой цветовой модели L*a*b. На 
рис. 2.5 схематически представлены соотношения цветовых охватов этой моде-
ли и моделей RGB и CMYK. Из этой схемы ясно, что больше половины цветов, 
которые видит человек, и почти 20 % цветов, которые можно отобразить на эк-
ране монитора, не входят в цветовой охват основной полиграфической цвето-
вой модели CMYK. При работе с большинством современных графических 
программ выбор одного из таких цветов сопровождается выдачей предупреж-
дения о выходе за границы полиграфического цветового охвата. 

 
2.4. Методические указания по работе в пакете CorelDRAW 12 

(Продолжение. Начало см. подразд. 1.4) 
 

Все объекты, содержащие открытые или замкнутые контуры, можно закра-
сить однородным цветом, градиентной заливкой, узором или текстурой. Про-
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грамма CorelDRAW предоставляет следующие инструменты придания цвето-
вых характеристик цвета объектам: 

– заливка; 
– инструмент Fill; 
– универсальная заливка и инструмент Interactive Fill; 
– заливка по сетке и инструмент Interactive Mesh Fill; 
– инструменты Eyedropper и Paintbucket. 
1. Заливкой называют закраску внутренней части контура. Обычно заливку 

применяют только к объектам с замкнутым контуром. Чтобы замкнуть произ-
вольную кривую, выделите объект, а затем нажмите на панели свойств кнопку 
Auto-Close Curve (Замкнуть кривую). 

Если требуется залить объект с открытым контуром, выполните команду 
меню: Tool -> Options (Инструменты -> Параметры), в появившемся диалого-
вом окне Options выберите в древовидном списке слева раздел Document -> 
General (Документ -> Общее), а затем установите флажок Fill Open Curves 
(Заливать открытые контуры). 

По умолчанию у всех новых объектов нет заливки (режим None Fill), а в 
качестве обводки контура использован черный цвет. Чтобы быстро залить вы-
деленный объект цветом, щелкните по какому-нибудь цвету на любой палитре. 
Это самый простой вариант заливки, которая называется однородной заливкой. 

2. Градиентная заливка с помощью диалогового окна Fountain Fill. Диало-
говое окно Fountain Fill используется для выполнения градиентной заливки. 
Градиентная заливка – это постепенный плавный переход между двумя или не-
сколькими различными цветами. Направление и форма заливки определяются ее 
типом. Различают линейную (Linear), коническую (Conical), радиальную (Ra-
dial) и квадратную (Square) градиентные заливки (рис. 2.6). Линейная заливка – 
самый распространенный тип градиентной заливки. Она обеспечивает постепен-
ный плавный переход от одного цвета к другому. Коническая заливка использу-
ется для имитации трехмерных конических объектов. Радиальная заливка при-
меняется для сферических или шаровидных, а квадратная – для пирамидальных 
фигур. Если требуется применить градиентную заливку к одному или несколь-
ким определенным объектам, выделите их, после чего щелкните по кнопке Foun-
tain Fill Dialog (рис. 2.7) раскрывающейся панели инструмента Fill. 

 

  
 

Рис. 2.6. Типы градиентных заливок 
 

Рис. 2.7. Панель  Fountain Fill Dialog 
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Для задания градиентной заливки вновь создаваемых объектов отмените какие-
либо выделения объектов в документе, щелкнув мышью в свободном месте, а затем 
щелкните по кнопке этого диалогового окна. На экране появится предварительное 
окно с предложением выбрать тип объектов, к которым будет применяться указан-
ный цвет заливки по умолчанию, после этого можно нажать кнопку ОК. 

В этой лабораторной работе следует освоить работу с интерактивными ин-
струментами и командами, предназначенными для создания специальных ху-
дожественных или объемных эффектов (рис. 2.8–2.12). Последние получаются 
в результате искажения или добавления новых элементов к векторному объек-
ту. Почти все нижеперечисленные эффекты можно использовать при работе с 
любыми типами объектов CorelDRAW, включая растровые изображения: 

 

 
 

Рис. 2.8. Пример применения эффекта 
контуров 

2.9. Пример применения эффекта 
выдавливания  

 
– перетекания и инструмент Interactive Blend; 
– контуры и инструмент Interactive Contour; 
– искажение и инструмент Interactive Distortion; 
– огибающая и инструмент Interactive Envelope; 
– выдавливание и инструмент Interactive Extrude; 
– тени и инструмент Interactive Drop Shadow; 
– прозрачность и инструмент Interactive Transparency; 
– перспектива; 
– линза и закрепленное окно Lens; 
– фигурная обрезка и команда PowerClip 

 

  
 

Рис. 2.10. Пример применения эффекта перетекания 
 
3. Перетекание – это операция, в результате которой между двумя исход-

ными объектами создается определенное количество промежуточных по форме и 
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цветовым параметрам объектов (см. рис. 2.10). Траекторией перетекания может 
являться как кривая, так и прямая линия между двумя исходными объектами, по 
которой будет осуществляться перетекание. После создания эффекта допускает-
ся изменять исходные объекты и траекторию, чтобы получить его различные ва-
риации. Этот эффект широко используется для выполнения подсветки, бликов 
либо для формирования гибрида из многочисленных копий исходных объектов. 

4. При применении инструмента Interactive Contour на основе исходного 
контура объекта создаются концентрические контурные линии, благодаря ко-
торым создается эффект перетекания (см. рис. 2.8). Последовательность конту-
ров может направляться как в центр объекта, так и вовнутрь или наружу. При 
этом может происходить плавный переход между цветами объекта и конечны-
ми цветами, заданными пользователем. Контуры могут применяться к любому 
объекту, включая художественный текст или объекты с открытым контуром. 

 

  
 

Рис. 2.11. Пример применения 
эффекта тени 

 
Рис. 2.12. Пример применения эффекта 

«огибающей» вокруг блока текста 
 
5. Перспектива. Применение эффекта перспективы позволяет создавать ил-

люзию удаленности объемного объекта. Для придания объекту перспективы ис-
пользуется команда Add Perspective (Добавить перспективу) пункта меню Effects 
(Эффекты). Эффект можно применять к любому векторному объекту, исключая 
растровые изображения и блоки простого текста. Эффект перспективы состоит в 
следующем: поверх векторного объекта накладывается плоскость в виде прямо-
угольной пунктирной сетки, в углах которой расположены четыре маркера. Для 
придания объекту перспективы необходимо соответствующим образом переме-
щать эти маркеры (см. рис. 2.9). 

 
2.5. Указания к индивидуальной разработке графических проектов 

на основе векторной графики 
 
Как показывает практика, у студентов возникают трудности с освоением 

техники рисования, заключающейся в построении сложных объектов из кривых 
и их различных комбинаций. Эти комбинации объектов, должны, в конце кон-
цов, привести к законченным графическим образам, разработке которых посвя-
щена данная лабораторная работа. 

Выполнить самостоятельно следующие проекты: 
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1. Разработать макет поздравительной открытки на тему Международного 
женского дня 8-ое марта, дня святого Валентина, Нового года. 

2. Рисунок на детскую и сказочную тематику (этот стиль позволяет скрыть 
отсутствие умения рисовать). 

3. Геометрический натюрморт с имитацией трехмерности объектов (конус, 
шар, призма, цилиндр), объемного освещения и материальности поверхности. 

4. Макеты визиток с логотипами известных производителей и фирм. 
Рисование объектов проводить с использованием кривых Безье или инст-

рументом Умная кисть. Для раскраски объектов использовать градиентные за-
ливки, инструменты Художественная кисть, Грубая кисть и Размывающая 
кисть, интерактивные эффекты и художественный текст с использованием на-
правляющих линий и огибающих. Разработанный графический образ сопрово-
дить подробным описанием последовательности применения инструментов для 
получения объектов, составляющих образы проекта. 

На рис. 2.13–2.15 приведены проекты, выполненные студентами, и пример 
описания последовательности действий к одному из них. 

Описание действий при создании объектов и образов проекта на рис. 2.13. 
1. Фон: прямоугольник в верхней половине листа; заливаем линейным гра-

диентом (голубой – белый), под ним второй прямоугольник; заливаем линей-
ным градиентом (черный – зелёный). 

2. Дуб: ствол, крона, ветки – инструмент Freehand Tool. Заливка кроны – 
текстура Vegetation (черный, яркий зелёный), заливка ствола и ветки – тексту-
рой Yellow foil (черный, коричневый). 

3. Кот: туловище – кривые Bezier Tool, корректируем изображение с помощью 
Shape Tool, заливаем линейным градиентом (черный – белый), затем хвост. 

4. Мордочка кота: глаза – овал, вытянутый вертикально, заливка желтым 
цветом. Внутри него узкий овал такой же высоты, заливка черным. Рисуем рес-
ницы (Bezier Tool, Shape Tool). Выделяем полученный глаз, ресницы, группиру-
ем, используем Transformations -> Sсale-> Mirror-> Apply to Duplicate. Полу-
чаем второй глаз, располагаем их, как нам требуется. 

5. Щёки: рисуем одну щеку, отражаем горизонтально с одновременным ко-
пированием (Transformations -> Sсale-> Mirror-> Apply to Duplicate), выделяем 
одновременно две половинки, комбинируем (Combain). Выделяем с помощью 
Shape Tool узлы, которые надо объединить, используем Join Two Nodes. Залив-
ка градиентом (белый – черный – белый), рисуем нос и усы. Всё группируем. 

6. Уши: кривые Bezier Tool из двух частей – черной и светло-серой. Груп-
пируем, копируем, отражаем и присоединяем к голове кота. Размер и форму 
корректируем с помощью Shape Tool и Transformations -> Scale. Группировка 
всех частей кота в одну. 

7. Цепь: звено цепи рисуем с помощью Freehand Tool, делаем контур тол-
ще, желтого цвета. Копируем звено 6 раз, располагаем звенья поперёк ствола 
дуба, группируем. 
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8. «Ставим» кота на цепь. Рисуем грибы и траву c помощью Bezier Tool и 
Freehand Tool, используя необходимые заливки. Подпись к рисунку («У Луко-
морья дуб зелёный...») – Text Tool. 

 

 
 

 

Рис. 2.13. Рисунок в стиле 
«мультики» 

2.14. Образцы визиток Рис. 2.15. Геометрическая 
композиция 

 
Лабораторная работа №3 

 
Разработка графических проектов с использованием пакета растровой 

графики Photoshop CS2 
 

Цель работы: 
1. Освоить работу с инструментами программы Photoshop CS2: 
а) выделение. Выделение прямоугольных и эллиптических областей. Пе-

ремещение области выделения выделенного объекта. Дублирование и редакти-
рование выделенных областей. Выделение с помощью инструмента Волшеб-
ная палочка. Выделение с помощью инструмента Магнитное лассо. 
Комбинирование различных областей выделения; 

б) ретуширование и восстановление фотоизображений. Обрезка фото-
графий. Поворот и одновременная обрезка фотографий. Настройка тонового 
диапазона. Замена цвета в изображении. Увеличение насыщенности инстру-
ментом Губка (Sponge). Увеличение яркости инструментом Осветление 
(Dodge). Увеличение резкости. Удаление и восстановление элементов изобра-
жения. Удаление морщин на лице; 

в) слои документа. Создание и удаление слоев. Манипулирование слоями. 
Слияние слоев. Маски и каналы. Быстрая маска. Градиентная маска. Обрезаю-
щая маска. Настроечные слои. Маски слоев;  

г) освоить работу с текстом в программе Photoshop CS2. Редактирование 
текста в текстовых слоях и эффекты при работе с текстом. 

2. Освоить применение эффектов слоев и фильтров в Photoshop CS2. 
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Основные характеристики и виды пиксельных изображений. 
Форматы растровой графики 

 
В этой части рассматриваются: основные характеристики пиксельного изо-

бражения, наиболее распространенные форматы представления пиксельных 
изображений, приемы создания, преобразования и использования пиксельных 
изображений. 

 
3.1. Разновидности пиксельных изображений 

 
На практике приходится сталкиваться с большим разнообразием представ-

лений пиксельных изображений, но в основе каждого из них лежит одна и та же 
информационная модель. Согласно этой модели, изображение рассматривается 
как растр, то есть прямоугольная матрица отдельных пикселов (точек), для ка-
ждой из которых фиксируются значения параметров, определяющих цвет изо-
бражения в этой точке. 

Количество и смысл параметров, определяющих цвет, зависят от цветовой 
модели, выбранной при создании пиксельного изображения или в процессе пре-
образования последнего. Совокупность значений параметров, фиксирующих 
цвет пиксела, составляет дескриптор пиксела. Совокупности дескрипторов, соот-
ветствующих всем пикселам изображения, приведенным в фиксированной по-
следовательности, образуют базовую информационную модель пиксельного изо-
бражения. Типы пиксельных изображений, соответствующие различным 
цветовым моделям, следующие: штриховые, монохромные, индексированные, 
полноцветные. В табл. 1 приведены сведения о размерах дескрипторов пиксе-
лов для перечисленных выше типов изображений и о количестве различных 
цветов, которые могут использоваться в этих изображениях. 

Под разрешением понимается количество пикселов, приходящихся на 
единицу длины пиксельного изображения. Разрешение по горизонтали (вдоль 
строк растра) и по вертикали (вдоль столбцов растра) может быть различным, 
но в большинстве случаев выбирается одинаковым во избежание искажения 
изображения. Традиционной единицей измерения разрешения является ppi (pix-
els per inch – пикселы на дюйм). Чтобы получить разрешение в пикселах на сан-
тиметр (pps), следует воспользоваться одной из следующих формул перевода: 

Rpps= Rppi /2,54; 
Rppi=0,4 Rpps , 

 

где Rpps – разрешение, выраженное в пикселах на сантиметр, Rppi  – разрешение, 
выраженное в пикселах на дюйм. 

В практической работе разрешение выбирается в зависимости от требуе-
мых результатов графического проекта. Как правило, решающими факторами 
при выборе разрешения изображения оказываются аппаратная разрешающая 
способность графических устройств, осуществляющих финальный вывод изо-
бражения, и особенности эффекта смыкания. 
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Таблица 1 
Характеристики пиксельных изображений различных типов 

 

Тип пиксельного 
изображения 

Размер 
дескриптора (бит) 

Глубина 
цвета (бит) 

Количество 
цветов 

Штриховое 1 2 2 
Индексированное От 2 до 8 От 2 до 8 От 4 до 256 
Монохромное 8 8 256 оттенков 
Полноцветное 8 24 16 777 216 
Полноцветное, 
повышенной точности 16 48 281 474 976 710 656 

 
Значение разрешения зависит от двух факторов: количества пикселов в 

строках и столбцах растра пиксельного изображения и от габаритов, с которы-
ми воспроизводится это изображение. Предположим, что в нашем распоряже-
нии имеется пиксельное штриховое изображение (например рисунок), имеющее 
размеры 600 пикселов по горизонтали и 1200 пикселов по вертикали. В табл. 2 
представлены габариты и размеры отдельного пиксела изображения при его 
воспроизведении с различными разрешениями. 

 
Таблица 2 

Влияние разрешения на размер изображения 

 
По данным табл. 2 видно, что одно и то же пиксельное изображение при 

воспроизведении может иметь габариты от сравнимых с почтовой маркой до 
сравнимых с листом формата А4. Для расчета размеров пиксельного изображе-
ния после вывода на печать можно воспользоваться следующими формулами: 

Lвыв = Nгор/ Rпр;        
Нвыв  = Нвер / Rпр,        

где Lвыв – размер пиксельного изображения по горизонтали после вывода; 
      Nгор – количество пикселов в строке растра пиксельного изображения; 

Размер изображения (мм) Разрешение 
изображе-
ния (ppi) 

Разрешение 
изображения 
(мм) 

по 
горизонтали 

по 
вертикали 

Размер 
пиксела 
(мм) 

72 211,7 423,3 0,35 
96 158,8 317,5 0,26 
150 101,6 203,2 0,17 
300 50,8 101,6 0,08 
600 25,4 50,8 0,04 
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   Нвыв – размер пиксельного изображения по вертикали после вывода; 
   Нвер – количество пикселов в столбце растра пиксельного изображения; 
   Rпр – аппаратное разрешение принтера или иного устройства вывода. 

Разрешение и размер файла изображения. Размер файла с пиксельным 
изображением зависит от разрешения пиксельного изображения и от цветовой 
модели. Сначала определим количество пикселов в растре, представляющем 
изображение. Для этого следует перемножить размеры растра в пикселах по го-
ризонтали и вертикали. Полученное число умножается на глубину цвета, соот-
ветствующую использованной цветовой модели (см. табл. 1). Полученное число 
представляет собой объем памяти выраженный в битах, необходимый для хра-
нения дескрипторов всех пикселов изображения. Чтобы определить размеры 
файлов в байтах, полученный результат следует разделить на восемь. Напри-
мер, пиксельное изображение размером 640*480 пикселов в цветовой модели 
RGB с обычной глубиной цвета потребует для своего хранения 
(640*480*24)/8=921 600, или примерно 920 Кбайт. При использовании моно-
хромной модели размер файла будет примерно в три раза меньше. Этот подсчет 
лишь приблизительно оценивает размер файла, поскольку кроме дескрипторов 
пикселов в файле могут храниться и дополнительные элементы информацион-
ной модели пиксельного изображения (например слои и маски). 

Размеры пиксельных изображений, предназначенных для вывода на пе-
чать, могут достигать огромных величин – сотни, иногда тысяча с лишним ме-
габайтов. Поэтому следует придерживаться простого правила: размеры пик-
сельного изображения в пикселах и его разрешение должны точно 
соответствовать назначению этого изображения. Для подбора композиции, вер-
стки документов и оценки предварительных вариантов вместо громоздких изо-
бражений с высоким разрешением вполне можно пользоваться их вариантами с 
теми же размерами, но пониженным разрешением.  

Разрешающая способность устройств вывода. Для воспроизведения пик-
сельных изображений могут применяться различные устройства. Наиболее часто 
изображения воспроизводятся на экранах компьютерных мониторов, принтерах, 
устройствах вывода на слайды и на прозрачную пленку (фотонаборных автоматах). 
У каждого из этих типов устройств имеются свои специфические особенности, 
влияющие как на их аппаратную разрешающую способность, так и на подготовку 
пиксельных изображений для воспроизведения. 

Экран монитора. Аппаратная разрешающая способность монитора опреде-
ляется технологией изготовления его электронно-лучевой трубки или жидкокри-
сталлической панели, содержащей ячейки для воспроизведения пикселов пик-
сельного изображения. Стандарт SuperVGA предполагает, что на экране монитора 
воспроизводится 800 пикселов по горизонтали и 600 пикселов по вертикали. На 
мониторе с размером диагонали 14 дюймов это соответствует аппаратной разре-
шающей способности примерно 96 пикселов на дюйм. В современных мониторах 
пользователь имеет возможность выбрать один из нескольких возможных вариан-
тов аппаратной разрешающей способности средствами операционной системы. 
Аппаратная разрешающая способность монитора не связана с разрешением пик-
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сельного изображения, которое на нем воспроизводится. Если численные значе-
ния этих величин совпадают, изображение будет воспроизведено на экране в на-
туральную величину. Однако если разрешение изображения выше, чем разре-
шающая способность монитора, размеры изображения на экране будут больше его 
истинных размеров. Пусть изображение представляет собой квадрат со стороной 1 
дюйм и разрешением 300 ppi. При выводе такого изображения на экран монитора 
с аппаратным разрешением 72 ppi размеры квадрата будут в четыре с лишним 
раза больше, поскольку при выводе пиксельного изображения на экран каждому 
пикселу растра изображения ставится в соответствие пиксел растра экрана мони-
тора. Поэтому при подготовке изображений для вывода на экран монитора следу-
ет руководствоваться следующим правилом: разрешение изображения должно со-
ответствовать разрешающей способности экрана. 

Расчет необходимых значений разрешения. Перед работой с пиксель-
ным изображением необходимо решить, каковы должны быть его размеры и 
разрешение. Это решение определяет как подбор необходимых изображений, 
так и последующую работу с ними. Основной фактор в определении разреше-
ния пиксельных изображений – технология их воспроизведения в окончатель-
ном варианте информационного продукта. Например, если предполагается на-
печатать тираж на полиграфическом оборудовании офсетным методом, 
разрешение изображений будет выше, чем разрешение изображений, входящих 
в медийную презентацию, которую предполагается демонстрировать на экране. 

Экранные и мультимедийные приложения. Большинство современных 
проекционных устройств, использующихся для демонстрации изображений на 
больших экранах, отображают 640*480 или 1024*768 пикселов. Последнее зна-
чение характерно и для подавляющего большинства экранов мониторов. Теле-
визионный стандарт PAL фиксирует размер изображения растром 525*480 пик-
селов. При выводе изображения на экран проектора, монитора или телевизора 
нет необходимости создавать изображения с большим разрешением, чем аппа-
ратное разрешение экрана, – это приведет только к неоправданным затратам 
памяти и замедлению работы с изображением. 

Превышение разрешения изображений над аппаратным разрешением экра-
на ни в коей мере не способствует увеличению реалистичности этого изобра-
жения. Для повышения реалистичности скорее следует в процессе создания и 
демонстрации изображений использовать компьютер с видеокартой, способной 
отображать большое число оттенков цвета, и применить полноцветную цвето-
вую модель. Количество цветов, воспроизводимых на экране, зависит не от раз-
решения изображения, а от использованной при его создании цветовой модели, 
типа видеокарты, которой оснащен компьютер, и объема видеопамяти. 

Штриховые изображения. К категории штриховых относится очень мно-
го изображений: логотипы, чертежи, гравюры, рисунки, офорты. Такие изобра-
жения часто размещают в качестве иллюстраций в тексте и в коммерческих объ-
явлениях. Отсутствие в штриховых изображениях оттенков базового цвета 
заставляет художника передавать оттенки большим числом тонких штрихов и 
точек. Эта особенность приводит к тому, что для точного воспроизведения штри-
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ховых изображений их приходится выводить на печать с повышенным разреше-
нием. Из-за этого при выводе на экран (с вынужденно низким разрешением) 
многие из штриховых изображений выглядят недостаточно хорошо. По указан-
ной причине штриховые изображения нужно создавать или сканировать с раз-
решением, равным аппаратному разрешению устройства, которое будет для это-
го использовано. Как правило, офисные лазерные принтеры воспроизводят 
штриховые изображения с достаточно высоким качеством. 

Случаи изменения размеров изображения. При работе с программами 
редактирования изображений и верстки документов приходится изменять раз-
меры пиксельного изображения – масштабировать его. При увеличении линей-
ных размеров изображения разрешение падает. Например, если изображение 
размером 2*2 дюйма, созданное с разрешением 300 ppi, при выводе увеличива-
ется в два раза, разрешение падает вдвое – до 150 ppi. Это происходит из-за то-
го, что программе приходится увеличивать каждый пиксел, чтобы то же их 
число разместить на большем пространстве. Поэтому может исчезнуть эффект 
смыкания и отпечаток изображения станет непригодным. Чтобы компенсиро-
вать подобное снижение разрешения, изображение, которое в дальнейшем 
предполагается увеличивать, следует создавать или сканировать с повышенным 
разрешением. Значение этого разрешения можно рассчитать по формуле  

Ri = (Lpr max∙Rpr∙k) / Li
 
max,       (1) 

где Ri – разрешение, с которым следует создавать изображение; 
Lpr max – больший габаритный размер отпечатка; 
Li max – больший габаритный размер изображения; 
Rpr – линиатура полиграфического растра (аппаратная разрешающая спо-

собность полиграфического оборудования); 
k – коэффициент перехода от пикселов к элементам растра (от 1,5 до 2). 
Приведем пример расчета. Предположим, что изображение размером 1*3 

дюйма при печати придется увеличить до размера 2*6 дюймов. Линиатура по-
лиграфического растра равна 150 lpi. Больший габаритный размер отпечатка в 
этом случае равен 6 дюймам, изображения – 3 дюймам. В результате разреше-
ние будет равно (6*150*2)/3*600. То есть изображение следует создавать или 
сканировать с разрешением не более 600 spi (spi – характеристика сканера). 

Формула (1) полезна при определении разрешения сканированных изобра-
жений, которые впоследствии будут масштабированы. Например, если изобра-
жение, полученное в результате сканирования слайда стандартных размеров (с 
пленки шириной 35 мм, длина кадра которой равна примерно 1,375 дюйма), 
придется увеличивать до 5 дюймов и выводить на принтер с линиатурой 150 lpi, 
сканировать слайд следует с разрешением (5*150*2)/1,375 = 1100 spi. 

Регулировка размеров пиксельного изображения требуется во многих слу-
чаях, например при увеличении или уменьшении изображения в окне графиче-
ской программы. Для того чтобы она стала возможной, приходится прибегать к 
изменению числа пикселов, составляющих растр пиксельного изображения, т.е. 
к повторному растрированию. 
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Увеличение числа пикселов в растре. Увеличение количества пикселов в 
растре можно рассматривать как наложение поверх исходного растра второго 
растра с более частым расположением пикселов. При этом за исключением ча-
стного (но очень важного!) случая, при котором количество пикселов нового 
растра по строкам и столбцам кратно количеству пикселов исходного растра, 
границы пикселов старого и нового растров не совпадают. Возникает проблема 
определения значений параметров цвета: какой цвет должен иметь пиксел но-
вого растра, если треть его перекрывает синий пиксел старого растра, а две тре-
ти – расположенный рядом с ним красный пиксел? Для решения этой проблемы 
используется несколько вариантов интерполяции цвета. 

Интерполяцией цвета называется определение значений параметров цвета 
при повторном растрировании. В современных графических программах интерпо-
ляция цвета выполняется в соответствии с одним из трех алгоритмов: 

– по ближайшему пикселу. В этом случае отыскивается пиксел старого 
растра, центр которого расположен ближе всех к центру пиксела нового растра, и 
содержащиеся в его дескрипторе значения параметров цвета копируются в деск-
риптор пиксела нового растра. Если от центра пиксела нового растра равноуда-
лены центры нескольких пикселов старого растра, для извлечения значений па-
раметров цвета выбирается один из них, например всегда верхний левый; 

– по формуле линейной интерполяции. В этом случае параметры цвета 
пикселов нового растра определяются с учетом цветов всех пикселов старого 
растра, части которых он перекрывает. Вклад цветов пикселов старого растра в 
в пикселы нового растра определяется по методу линейной интерполяции; 

– по формуле кубической интерполяции. В этом случае цвет пиксела но-
вого растра определяется также с учетом цветов всех пикселов старого растра, 
части которых он перекрывает, но интерполяция выполняется точнее за счет 
применения более сложного метода кубической интерполяции. 

Уменьшение числа пикселов в растре. При повторном растрировании пик-
сельного изображения с уменьшением количества пикселов, составляющих растр, 
возникают проблемы с определением значений параметров цвета. Когда границы 
пикселов нового и старого растров не совпадают, цвет одного пиксела нового рас-
тра приходится определять на основе цветов нескольких пикселов старого растра. 
Если в случае увеличения числа пикселов интерполяцию приходится выполнять 
только для новых пикселов, пересекающих границы старых пикселов, то при 
уменьшении числа пикселов интерполяция выполняется для всех новых пикселов.  

 
3.2. Основные форматы пиксельных изображений 

 
Форматом графического файла называется способ представления данных 

информационной модели в виде файла, располагающегося на одном из уст-
ройств долговременного хранения информации. В настоящее время активно 
используемых форматов насчитывается более сотни. Рассмотрим только наибо-
лее распространенные форматы пиксельных изображений и применяющиеся в 
них методы сжатия данных. 
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Методы сжатия. Компрессией графической информации называется пре-
образование пиксельной информационной модели в более компактную форму 
за счет удаления из нее избыточной информации. Все методы сжатия предпола-
гают поиск в пиксельном изображении повторов и закономерностей и замену 
дескрипторов всех без исключения пикселов более крупными структурными 
единицами. Различают методы сжатия без потери графической информации 
(неразрушающие) и с контролируемой степенью ее потери (разрушающие). 
Первые позволяют произвести преобразование, обратное по отношению к сжа-
тию, и полностью восстановить исходный растр (неразрушающее сжатие), вто-
рые такой возможности не дают, но позволяют получить намного более ком-
пактное представление изображения, занимающее иногда в десятки и сотни раз 
меньше места (разрушающее сжатие). 

Простейшей методикой сжатия является RLE (Run Length Encoding – коди-
рование с переменной длиной строки). При сжатии по методу RLE в строке ис-
ходного растра отыскиваются непрерывные последовательности пикселов оди-
накового цвета. Затем такая последовательность заменяется дескриптором, 
содержащим коэффициент повторения в виде числа и дескриптор повторяюще-
гося пиксела. Предположим, что в строке располагаются подряд 22 пиксела бе-
лого цвета, 51 – черного и 10 – синего, тогда вместо 83 дескрипторов отдельных 
пикселов после сжатия строка будет состоять всего из трех дескрипторов. Метод 
RLE дает хорошие результаты при работе с изображениями, созданными с по-
мощью графических редакторов, и плохие – при работе с фотографиями. А если 
фотография содержит большое число мелких деталей, то после сжатия по методу 
RLE вместо сокращения размера файла может получиться его увеличение. Этот 
метод обеспечивает полное восстановление графической информации. 

Метод сжатия LZW назван по первым буквам фамилий его разработчиков 
(Lempel-Ziv-Welch). Он более эффективен, чем RLE, но требует больше време-
ни на сжатие и распаковку данных. По этому методу в результате анализа рас-
тра выявляются повторяющиеся комбинации пикселов, из них составляется 
словарь, и каждой комбинации присваивается ключ – число, занимающее в па-
мяти меньше места, чем эта комбинация. Так же, как метод RLE, метод LZW 
более эффективен при сжатии изображений с однородными областями, свобод-
ными от цветовых шумов, но дает значительно лучшие результаты. Из-за этого 
метод LZW в настоящее время является наиболее распространенным методом 
неразрушающего сжатия. Самым известным и широко применяющимся мето-
дом разрушающего сжатия является JPEG. Первоначально он предназначался 
для цифровой фотографии, и сейчас практически все цифровые камеры па ап-
паратном уровне реализуют сжатие снимаемых фотографий по этому методу. 

Этот метод сжатия основан на поиске не одинаковых структурных элемен-
тов в растре, как в RLE и LZW, а закономерностей в изменении цвета пикселов. 
Сжатие проходит несколько этапов. Сначала пиксельное изображение преобра-
зуется в цветовую модель L*a*b, затем отбрасывается половина или три чет-
верти информации о цвете (в зависимости от реализации алгоритма). Далее ана-
лизируются группы пикселов размером 8*8 пикселов. Для каждой группы 
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формируется дескриптор, описывающий как группу в целом, так и закономерно-
сти изменения цветового тона в ней. Закономерности выбраны с учетом особен-
ностей зрительного восприятия изображения, поэтому после сжатия крупные 
детали изображения сохраняются лучше мелких. На следующем этапе задается 
степень сжатия, и в соответствии с этим параметром из информационной моде-
ли удаляются данные о более или менее мелких деталях. Чем выше степень 
сжатия, тем больше данных удаляется, тем меньше становится графический 
файл и тем ниже становится качество. Метод JPEG позволяет при приемлемом 
для многих целей снижении качества получить файл в 100 раз меньше исходно-
го (на практике – от 5 до 15 раз). Для хранения изображения, сжатого по методу 
JPEG, используется специальный формат файла. 

Формат СРТ (Соrеl Photo-Paint Image). Стандартный формат для хране-
ния растровых изображений программы Соrеl PhotoPaint и CorelDRAW, спосо-
бен сохранять все, что возможно создать в этих программах при работе с то-
чечной графикой. Основной недостаток – плохая поддержка другими 
редакторами, например, Photoshop. Однако если вы отдаете предпочтение про-
дуктам компании Соrel, формат СРТ – это достаточно оптимальный выбор. 

Формат JPEG 2000. Постепенно набирает популярность и в ближайшие го-
ды заменит формат JPEG. Основным его отличием является то, что он способен 
сжимать файлы практически без потери качества (ухудшения качества не видно). 

Формат PCX. Один из форматов, которые неплохи сами по себе, но вы-
тесняются другими. РСХ поддерживает RLE-компрессию (см. выше). Он под-
держивает цветовые модели Bitmap, Grayscale, Indexed colors, RGB. Однако 
РСХ не поддерживает цветовую модель СМYК. Кроме того, этот формат не 
умеет сохранять дополнительные каналы. Таким образом, лучше его не исполь-
зовать. Этот формат прекрасно заменит более распространенный ТIFF. 

РIСТ (Macintosh QuickDraw Picture Format). Используется, в основном, 
на компьютерах Macintosh. Поддерживается всеми программами на этих компь-
ютерах и даже служит стандартом буфера обмена. При сохранении в РIСТ вы 
можете использовать цветовые режимы Bitmap, Grayscale, Indexed colors, RGB, 
СМYК. В RGB-файле можно сохранить один альфа-канал, в остальных режимах – 
несколько. РIСТ способен хранить векторную информацию, текст и звук. Этот 
формат имеет достаточно неплохие возможности для сжатия при условии нали-
чия больших областей одного цвета (RLE-компрессия). 

Формат BMP был разработан как основной графический формат для систе-
мы Windows и предусматривает хранение изображений, использующих индекси-
рованную модель цвета без сжатия, поэтому формат BMP редко применяется в 
художественной графике и вовсе не применяется в издательской практике. Файлы 
в этом формате могут обрабатываться программами, работающими как на компь-
ютерах PC, так и на Macintosh – формат не зависит от платформы. 

Формат GIF. Первая версия формата GIF (Graphics Interchange Format) 
была разработана в 1987 году специально для передачи пиксельных графиче-
ских изображений в глобальных компьютерных сетях. В 1989 году формат был 
модифицирован (GIF89a) с добавлением очень важных возможностей. Формат 
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использует сжатие по методу LZW и чересстрочную передачу графических 
данных. Это означает, что по сети вначале передаются не все строки растра, а 
только 1, 5, 10 и так далее с увеличением размеров пикселов и снижением раз-
решения. Затем передаются строки 2, 6, 11 и так далее с последующим увели-
чением разрешения воспроизводимого изображения. Это позволяет увидеть 
черновую версию изображения в окне веб-браузера задолго до того, как оно бу-
дет загружено полностью. Пользователь может составить представление об 
изображении и решить, стоит ли ждать окончания загрузки. 

Формат GIF работает только с индексированной цветовой моделью. Поэто-
му в цветовой палитре пиксельного изображения можно указать один или не-
сколько цветов в качестве прозрачных и пикселы с такими цветами не будут 
воспроизводиться на экране. Кроме того, в файле формата GIF может содержать-
ся описание не одного, а нескольких пиксельных изображений. Браузер и неко-
торые графические программы позволяют демонстрировать эти изображения по-
следовательно с заданной частотой. Эта возможность лежит в основе пиксельной 
анимации, получившей широчайшее распространение в веб-дизайне (GIF-
анимация). Основной недостаток формата GIF – ограниченность индексирован-
ной модели цвета 256 вариантами.  

Формат TIFF. Аппаратно независимый формат TIFF (Tagged Image File 
Format – формат файла изображения с тегами) разрабатывался как универсаль-
ный формат для хранения результатов сканирования цветных изображений. В 
настоящее время его область применения существенно расширилась, он является 
одним из самых распространенных и надежных графических форматов, с ним 
могут работать практически все графические программы на PC и Macintosh.  

TIFF – наиболее подходящий формат для экспорта пиксельных изображе-
ний в программы векторной графики, настольные издательские системы и сис-
темы распознавания текста. Файл этого формата может содержать в себе пик-
сельное изображение в различных цветовых моделях: монохромной, RGB, 
CMYK и многоканальной с дополнительными каналами плашечных цветов. В 
составе файла могут содержаться описания слоев, обтравочных контуров, альфа-
каналов и другие дополнительные данные, в частности сведения о степени про-
зрачности любого из пикселов. Формат TIFF имеет две разновидности: для Mac-
intosh и PC. Современные графические программы способны автоматически рас-
познавать варианты формата и работать с любым из них. В формате TIFF 
допускается сжатие различными методами, в том числе LZW и ZIP. 

Формат RAW. Самый гибкий формат для обмена изображениями между 
компьютерами разных платформ. Можно сохранять изображения в любой цве-
товой модели, включая L*a*b и многоканальный, поддерживает альфа-каналы. 
На сегодняшний день RAW переживает второе рождение, так как это основной 
формат для многих цифровых фотоаппаратов. 

Формат JPEG получил свое название от соответствующего метода сжатия 
пиксельных изображений. Распаковка данных, содержащихся в файлах этого 
формата, выполняется автоматически во время их открытия. Файлы формата 
JPEG могут содержать монохромные и полноцветные изображения в цветовых 
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моделях RGB и CMYK. Поскольку используемый при создании файлов формата 
JPEG метод сжатия частично разрушает информацию исходного изображения, 
применение этого формата в полиграфических проектах категорически не реко-
мендуется. Однако потери качества за счет сжатия не настолько велики, чтобы 
быть заметными в изображениях, распечатываемых на принтерах среднего каче-
ства. Это обусловило широчайшую популярность формата в цифровой фотогра-
фии и веб-дизайне. Рекомендуется промежуточные версии проекта хранить в 
формате с неразрушающим сжатием, поскольку повторное сжатие при последова-
тельных многочисленных операциях сохранения файла может привести к практи-
чески полной деградации изображения. То же справедливо и в отношении импор-
та графических файлов в формате JPEG из цифровых камер. Рекомендуется перед 
обработкой (например ретушью) преобразовывать такие файлы в формат TIFF. 

Формат EPS (Encapsulated PostScript) является одним из наиболее слож-
ных форматов представления графической информации. Строго говоря, он не 
является форматом представления пиксельных изображений, область его при-
менения значительно шире – описание документов, содержащих текстовую и 
графическую информацию, как в пиксельной, так и в векторной форме. Перво-
начально он был разработан в качестве формата файлов для сохранения на дис-
ке описаний таких документов на упрощенной версии языка PostScript, непо-
средственно интерпретируемого высококачественными принтерами и 
фотонаборными автоматами. Не упомянуть этот формат невозможно в силу его 
универсальности и широкой распространенности в полиграфической практике, 
но для успешной работы с ним необходимо познакомиться со специальными 
описаниями как языка PostScript, так и формата EPS. 

Формат PSD (Adobe Photoshop Document) первоначально был разработан 
как формат сохранения графических файлов программы Adobe Photoshop, но по 
мере роста популярности и распространенности этой программы он приобрета-
ет некоторую универсальность, и многие современные графические пакеты мо-
гут открывать такие файлы. В формате PSD могут храниться изображения лю-
бого типа – от штриховых до полноцветных. В нем сохраняются все сведения о 
внутренней структуре документа: слои, каналы, тексты в векторной форме и 
многое другое.  

Формат PNG предполагает неразрушающее сжатие по методу Deflate, 
сходному с LZW. Он позволяет хранить практически все типы изображений при 
глубине цвета от 1 до 48 бит. Сжатые индексированные изображения в формате 
PNG, как правило, меньше аналогичных изображений в формате GIF, а изобра-
жение в цветовой модели RGB и формате PNG меньше в соответствующем фай-
ле формата TIFF. 

Используется двухмерный чересстрочный режим вывода на экран (не 
только строк, но и столбцов), который так же, как и в формате GIF, слегка уве-
личивает размер файла. В отличие от формата GIF, формат PNG позволяет 
«давать» градуированную прозрачность пикселов (в диапазоне прозрачности 
от 0 до 99 %) за счет включения в файл альфа-канала с 256 градациями серого.  

 

Би
бл
ио
те
ка

 БГ
УИ
Р



 50 

3.3. Методические указания и основные принципы работы 
в Adobe Photoshop 

 
Работа в Adobe Photoshop начинается либо с создания, либо с загрузки с 

диска, либо с импорта документа со сканера или цифровой камеры. Докумен-
том считается любое изображение, находящееся в рабочем окне графического 
редактора. Когда изображение находится в рабочем окне программы, к нему 
можно применять все доступные инструменты рисования и редактирования, 
эффекты и фильтры. Готовый документ можно сохранить в файле в одном из 
множества поддерживаемых форматов и напечатать. 

Выделение областей. Чтобы применить коррекцию или редактирование не 
ко всему изображению, а только к какой-либо его части, необходимо, прежде 
всего, выделить редактируемую область, которая на экране обозначается «дви-
жущейся» пунктирной границей. После этого можно переместить, скопировать 
или окрасить выделенный фрагмент, а также применить к нему разнообразные 
специальные эффекты. Выделенную область можно сохранить в альфа-канале в 
качестве маски. Adobe Photoshop обеспечивает несколько способов выделения 
фрагментов изображений: с помощью инструментов Область, Лассо или Вол-
шебная палочка, либо с помощью других команд. Каждое новое выделение от-
меняет предыдущее. Программа позволяет также модифицировать выделения 
различными способами. Кроме того, для выделения областей с высокой степе-
нью точности можно воспользоваться инструментом Перо, который создает век-
торные контуры. При создании векторных контуров достижима более высокая 
точность, чем при выделении обычными способами. Редактировать векторные 
контуры выделения значительно проще и удобнее, чем обычные. 

Слои. Изображение в Adobe Photoshop состоит из одного или нескольких 
слоев. Причем каждый из них абсолютно независим от остальных. Вы можете 
рисовать на любом слое, выполнять на нем любые операции редактирования, 
перемещать и удалять, временно выключать слои и изменять их прозрачность, 
не оказывая при этом влияния на объекты, находящиеся на других слоях. 

Изначально новый документ состоит из одного (фонового) слоя, называе-
мого Backround. Этот фон можно сравнить с холстом, на котором рисуется 
картина. Фон может быть белым либо окрашенным в текущий цвет заднего 
плана. Вы можете добавить в документ один или несколько слоев. Слои дают 
возможность редактировать отдельные элементы изображения независимо друг 
от друга. Разрешается рисовать, редактировать, вклеивать, маскировать и пере-
мещать содержимое любого слоя, не изменяя при этом объекты, расположен-
ные на других слоях. Новые слои, созданные в процессе работы над изображе-
нием, накладываются друг на друга так, что вышележащие перекрывают 
нижележащие. Каждый слой документа, кроме фонового (Background), может 
содержать прозрачные участки, сквозь которые видны объекты на нижележа-
щих слоях. Кроме того, изображение на каждом слое можно сделать частично 
прозрачным, и тогда сквозь него будут видны нижележащие слои. 
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Порядок расположения слоев в изображении можно произвольно изме-
нять, и это позволяет получать самые разнообразные эффекты, связанные со 
способами наложения пикселов, степенью непрозрачности и т.д. Вы можете 
также произвольно перемещать содержимое любого слоя в пределах окна до-
кумента. Существует возможность «связать» между собой несколько слоев и 
перемещать их содержимое одновременно. 

Кроме обычных слоев с изображениями в Adobe Photoshop используется 
особая разновидность слоев, называемых настроечными. Они позволяют приме-
нять к отдельным слоям или к группам слоев различные методы цветовой и то-
новой коррекции. Благодаря этому, можно свободно экспериментировать со все-
возможными комбинациями графических элементов, текста, специальных 
эффектов, вариантов непрозрачности и режимов наложения, не изменяя при этом 
фактического содержимого слоев. До тех пор, пока вы не объедините слои, каж-
дый из них будет оставаться независимым структурным элементом изображения. 

Еще одна разновидность слоев – текстовые слои. На изображении можно 
поместить любой объем текста для заголовков, названий и прочих надписей, 
без которых не обходятся рекламные листовки, проспекты, обложки. Каждая 
операция создания текста помещает его на отдельный, текстовый слой. В Adobe 
Photoshop текст хранится не в растровом, а в векторном виде. Поэтому его лег-
ко форматировать (изменять шрифт, начертание, размер, цвет, выравнивание) и 
редактировать (заменять и удалять символы, добавлять слова и т.д). Текстовый 
слой можно преобразовать в обычный (растровый). После этого надпись станет 
обычной точечной картинкой, и ее уже нельзя будет редактировать как текст. 

Добавление слоев приводит к увеличению объема документа. Прозрачные 
области слоя не влияют на размер файла. В целях экономии дискового про-
странства вы можете объединять отдельные слои, а также выполнять сведение 
всех слоев документа в один слой. Сведенное изображение состоит только из 
заднего плана и не содержит ни одного слоя, что существенно сокращает объем 
файла. Как правило, сведение выполняется только тогда, когда компоновка изо-
бражения завершена и нет необходимости редактировать содержимое отдель-
ных слоев. В процессе преобразования документа из одного цветового режима 
в другой сведение слоев выполняется автоматически. 

Чтобы ускорить процесс редактирования или печати изображения, вы мо-
жете временно сделать невидимыми те слои, которые в данный момент не ис-
пользуются. На печать выводятся только видимые слои. 

Маски и каналы. На основе цветовой модели, выбранной при создании 
нового изображения, Adobe Photoshop автоматически создает цветовые каналы. 
Например, каждое RGB-изображение по умолчанию содержит три канала: 
красный канал – для хранения информации о красном цвете, зеленый канал – 
для хранения информации о зеленом цвете и синий – для хранения информации 
о синем цвете. Документ также содержит совмещенный канал, в котором пред-
ставлена общая цветовая информация. Можете организовать просмотр любых 
комбинаций каналов. Adobe Photoshop использует каналы в двух целях: для 
хранения цветовой информации и для хранения масок, получаемых при сохра-
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нении выделенных областей. Маски позволяют защитить от изменения отдель-
ные участки изображения в процессе применения различных корректировок, 
фильтров и эффектов. 

Каналы, предназначенные для хранения масок, называются альфа-
каналами. Программа позволяет создавать и удалять альфа-каналы, а также 
изменять их свойства. Для редактирования масок, хранящихся в альфа-каналах, 
используются рисующие и стирающие инструменты. 

Маска представляет собой черно-белое изображение. Черный цвет маски 
всегда обозначает скрытые области, защищенные от редактирования, белый – 
видимые, доступные для редактирования, а серые – частично доступные для 
редактирования. Другими типами масок являются быстрые маски и слой-маски. 
Быстрые маски – временные. Они позволяют легко создавать область выделе-
ния сложной формы посредством закрашивания кистью участков изображения. 
В процессе создания быстрой маски программа позволяет видеть одновременно 
и маску, и изображение (рис. 3.1). 

Маска слоя позволяет предохранить от изменения отдельные участки слоя 
при использовании различных обработок, эффектов и фильтров. С ее помощью 
можно спрятать или показать целый слой или определенную область. Редактируя 
маску слоя, можно сделать доступными для редактирования или защитить опре-
деленные области слоя. После завершения редактирования можно применить мас-
ку, обрезав слой по ней, либо удалить маску без применения. Слой-маски могут 
использоваться также и для настроечных слоев. В этом случае они защищают уча-
стки слоя от воздействия корректирующих настроек, например цвета или тона. 

Маски могут быть созданы также из векторных контуров выделения. Такие 
маски называются векторными. Посредством растеризации векторную маску 
можно преобразовать в обычную. 

 

 
 

Рис. 3.1. Изображение морской звезды (справа) и маска альфа-канала (слева), 
защищающее изображение от редактирования 

 
Непосредственно под строкой заголовка находится строка меню с коман-

дами управления программой и изображениями, объединенными в группы: File 
(Файл), Edit (Правка), Image (Изображение), Layer (Слой), Select (Выделение), 
Filter (Фильтр), View (Вид), Window (Окно), Help (Помощь). Каждая группа – 
это совокупность команд, выполняющих функционально близкие действия.  
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Рис. 3.2. Панель инструментов       Рис. 3.3. Рабочее окно программы Photoshop 
             Adobe Photoshop 

 
Например, меню File (Файл) содержит команды для работы с файлами – 

создания, сохранения, открытия, а меню Select (Выделение) – для работы с вы-
деленной областью. Выбор команды меню осуществляется щелчком мыши на 
названии группы. В появившемся после этого подменю следует щелкнуть мы-
шью на имени нужной команды. 

Под полосой меню располагается панель параметров (Options Bar) с различ-
ными элементами управления – кнопками, флажками, открывающимися списками. 
С помощью панели параметров (Options Bar) настраиваются параметры выбранного 
инструмента. Поэтому доступные элементы управления зависят от того, какой ин-
струмент является текущим. Панель параметров (Options Bar) можно убрать с экра-
на и снова показать командой меню Window -> Options (Окно -> Параметры). Все 
инструменты Adobe Photoshop представлены в виде кнопок на панели инструмен-
тов (Tools) (рис. 3.2, 3.3, расположенной у левого края рабочего окна программы. 
Выбор инструмента осуществляется нажатием соответствующей кнопки. 

Эти инструменты предназначены для быстрого выполнения большинства 
операций и процедур, связанных с выделением, раскрашиванием, редактирова-
нием и просмотром изображений. Кроме того, панель инструментов содержит 
управляющие элементы для выбора цветов переднего и заднего плана, пере-
ключения в режим Quick Mask (Быстрая маска) и изменения способа отобра-
жения изображений на экране. 

Каждая кнопка имеет уникальный значок, благодаря которому легко запом-
нить ее назначение. На большинстве кнопок панели управления в правом ниж-
нем углу нарисован миниатюрный черный треугольник, означающий, что данная 
кнопка объединяет несколько инструментов. Достаточно нажать и не отпускать 
такую кнопку, чтобы появилось меню со списком скрытых инструментов. В этом 
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меню текущий инструмент обозначен миниатюрным черным квадратом. Выбор 
нужного инструмента из списка осуществляется обычным способом – щелчком 
мыши на инструменте. Все инструменты Adobe Photoshop объединены на панели 
инструментов (Tools) в группы, следующие одна за другой сверху вниз в сле-
дующем порядке (см. рис. 3.2): 

– инструменты выделения, обрезки и перемещения; 
– инструменты рисования и закрашивания, ретуширования; 
– инструменты создания контуров, текста и графических примитивов; 
– вспомогательные инструменты; 
– инструменты выбора цвета переднего плана и фона; 
– кнопки режимов работы; 
– кнопки режимов просмотра документа и переключения в ImageReady. 
Палитры. У правого края рабочего окна расположены три небольших окна, 

в которых сгруппированы управляющие палитры (см. рис. 3.3), предназначенные 
для выполнения самых разнообразных задач: перемещения по изображению, на-
стройки цветовых характеристик, отображения информации о выбранном объек-
те, выполнения операций со слоями и многих других. В своих окнах палитры 
представлены на вкладках. Название палитры указано на ярлыке вкладки. Чтобы 
сделать палитру активной, следует щелкнуть на ярлыке палитры. 

Палитры, которые Adobe Photoshop выводит на экран по умолчанию, име-
ют следующее назначение: 

Navigator (Навигатор) – перемещение по активному документу и изменение 
масштаба его отображения; 

Info (Информация) – отображение информации о цветовых значениях пик-
села под указателем мыши, координатах курсора, размере выделенной области 
и другое, в зависимости от инструмента; 

Histogram (Гистограмма) – отображение информации в виде графика (гисто-
граммы) о тоновом и цветовом диапазоне изображения; 

Color (Цвет) – отображение и выбор цвета переднего плана и фона посред-
ством указания цветовых значений составляющих; 

Swatches (Каталог) – выбор цвета переднего плана и фона; 
Styles (Стили) – отображение готовых стилей, которые могут быть приме-

нены к слоям изображения. Стили включают текстовые и фотографические эф-
фекты, текстуры, кнопки и др.; 

Layers (Слои) – отображение перечня всех слоев изображения с их пара-
метрами и эффектами, а также управление слоями; 

Channels (Каналы) – отображение перечня цветовых и альфа-каналов, 
имеющихся в изображении, для контроля результатов редактирования; 

Paths (Контуры) – отображение контуров, созданных в изображении и ис-
пользуемых обычно для создания областей выделения неправильной формы; 

History (События) – отображение всех операций, выполненных в текущем 
сеансе редактирования документа. С помощью этой палитры можно быстро от-
менить результаты и действия предыдущих операций и восстановить любое со-
стояние документа; 
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Actions (Действия) – запись, воспроизведение, редактирование и удаление 
последовательных операций редактирования. Данная палитра позволяет авто-
матизировать часто повторяющиеся операции. 

Кроме этого, из меню Window (Окно) можно открыть другие палитры: 
Animation (Анимация) – палитра для создания анимации; 
Brushes (Кисти) – отображает готовые кисти, позволяя выбрать кисть для 

работы и настроить ее параметры; 
Character (Символ) – содержит элементы управления для форматирования 

символов текста; 
Layer Comps (Снимок слоя) – отображает снимки состояния палитры сло-

ев (Layers); 
Paragraph (Абзац) – используется для форматирования абзацев текста; 
Tool Presets (Заготовки настроек инструментов) – отображает библиотеку 

заготовок настроек различных инструментов. 
Палитры, а также и панель инструментов (Tools) можно перемещать по эк-

рану, «ухватившись» за заголовок, и минимизировать, нажав кнопку в правом 
верхнем углу окна палитры или дважды щелкнув мышью на заголовке окна па-
литры. В таком режиме останутся видными только строка заголовка окна и яр-
лыки. Окно палитры можно также закрыть. Чтобы показать и скрыть палитру, 
нужно выбрать ее имя в меню Window (Окно). Но значительно удобнее вре-
менно убирать палитры и панель инструментов (Tools) нажатием клавиши, что-
бы освободить место на экране. Повторное нажатие этой клавиши вернет па-
литры на экран. Перетащив ярлык палитры, можно выделить ее в отдельное 
окно или поместить в другую группу палитр. Группирование палитр позволяет 
пользователю объединить палитры в соответствии со своими предпочтениями и 
решаемыми задачами. Чтобы восстановить исходное положение всех палитр, 
заданное разработчиками по умолчанию, следует выбрать команду меню Win-
dow -> Workspace -> Reset Palette Locations (Окно -> Рабочее пространство -> 
Восстановить положение палитр). 

Настроив по своему усмотрению положение палитр и окна открытых до-
кументов, вы можете сохранить рабочее пространство, воспользовавшись ко-
мандой меню Window -> Workspace -> Save Workspace (Окно -> Рабочее про-
странство -> Сохранить рабочее пространство). В дальнейшем можно 
использовать сохраненное рабочее пространство, выбрав его имя в меню Win-
dow -> Workspace (Окно -> Рабочее пространство). Таким образом, можно соз-
дать множество конфигураций программы для выполнения различных задач: 
рисования, ретуширования фотографий, подготовки документов к печати и 
других. Для удаления рабочего пространства можно будет воспользоваться ко-
мандой меню Window -> Workspace -> Delete Workspace (Окно -> Рабочее про-
странство -> Удалить рабочее пространство). 

Инструменты выбора цвета переднего плана и фона. Под перечислен-
ными группами кнопок на панели инструментов (Tools) расположены два на-
ложенных один на другой квадрата – черный и белый (рис. 3.4) Это образцы 
цвета переднего плана (Set foreground color) – левый верхний и фона (Set 
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background color) – правый нижний. Щелкая мышью на этих квадратах-
образцах, можно выбирать цвета для заливки и закрашивания кистью. 

 

 
 
Рис. 3.4. Выбор 
цвета и режимов 
работы 
 

Кнопки режимов работы. Под образцами цвета нахо-
дятся две кнопки для включения режимов: 

 – Edit in Standard Mode (Q) Редактирование в стандарт-
ном режиме (Q). Это основной (по умолчанию) режим работы 
в Adobe Photoshop. 
 

 – Edit in Quick Mask Mode (Q) Редактирование в режиме 
«Быстрая маска» (Q). Используется для создания и редактиро- 

вания временных масок, что обеспечивает возможность одновременного про-
смотра маски и изображения. Можно выделить в изображении первоначальную 
область, а затем войти в режим «Быстрая маска» и с помощью рисующих инст-
рументов модифицировать ее. После выхода из этого режима незащищенные 
участки будут преобразованы в выделенную область. 

 
3.4. Создание макета дизайна Web-страниц 

с помощью графического редактора Adobe Image Ready 
 
Программа Adobe Image Ready наряду с созданием анимации предназначена 

для оптимизации изображений, создания веб-страниц и ролловеров (элементов 
веб-страницы, меняющих свой вид в разных ситуациях). 

Отдельные элементы графического изображения на веб-странице часто ис-
пользуются как средства навигации. К каждому из них привязывается своя ссылка 
так, что, щелкнув на таком элементе, вы перейдете на другую страницу сайта 
или другой сайт. Кроме того, фрагменты одного изображения можно по-разному 
оптимизировать для просмотра в браузере. 

Фрагмент (Slice) – это прямоугольная область изображения. При сохранении 
изображения в виде веб-страницы каждый фрагмент сохраняется в отдельный 
файл. Отдельные фрагменты могут быть оптимизированы под разные форматы, 
одни, например, под GIF, а другие – под JPEG. Для разрезания изображения на 
фрагменты служит инструмент Slice Tool (Фрагмент), а для работы с фрагмента-
ми, т. е. для их выделения, перемещения и изменения размеров – инструмент Slice 
Select Tool (Выделение фрагмента), показанные на рис. 3.5. Включение линеек 
производится по команде View → Show Rulers (Вид → Показать линейку). 

 

 
 
Рис. 3.5. Инструменты Slice 

Tool и Slice Select Tool 

Для разрезания изображения на фрагменты не-
обходимо выполнить следующие действия. 
1. Установите направляющие линии, по которым бу-
дет происходить разрезание изображения. Направ-
ляющие линии разрезания вытаскиваются левой 
кнопкой мыши из областей вертикальной и горизон-
тальной линеек.  
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При расстановке направляющих старайтесь, чтобы фрагменты вмещали уча-
стки изображения сходных палитр цветов. Также разрезанию в Image Ready под-
лежат навигационные панели, кнопки и ссылки. Другим способом нарезания изо-
бражения на фрагменты является инструмент Slice Tool (Фрагмент). Он позволяет 
«вручную» выделять любые фрагменты, а остальные будут автоматически рас-
считаны и нарезаны программой. 

2. Выберите команду Slice → Create Slice from Guides (Фрагмент → Создать 
фрагменты по направляющим). Далее для выделения и манипуляций фрагментами – 
числом, размерами – используйте инструмент Slice Select Tool (Выделение фраг-
мента). Для объединения фрагментов используйте команду Slice → Combine Slices, 
а для разбивки фрагмента на подфрагменты применяйте команду Slice → Divide 
Slices. Режим показа/скрытия видимости границ фрагментов определяет команда 
View → Show → Slices (Вид → Показать → Фрагменты). 

3. Далее оптимизируйте и сохраните изображение. Выберите команду File → 
Save Optimized As (Оптимизировать и сохранить как). Включите опцию Save 
HTML File и Save Image. В результате все фрагменты будут сохранены как от-
дельные графические файлы в папке Images, которая автоматически создается 
внутри указанной папки. При этом создается HTML-файл, в котором прописан 
код таблицы размещения фрагментов изображения для правильной автоматиче-
ской сборки полного изображения. 

4. Для просмотра изображения в браузере выполните команду File → Preview 
in → Internet Explorer. Помимо изображения будет представлен HTML-код опти-
мизированного изображения. 

 
3.5. Указания к индивидуальной разработке графических проектов 

на основе растровой графики 
 
Назначение графических проектов, создаваемых студентами в этой работе, – 

освоение как можно более широкого набора инструментов и эффектов, приемов 
работы  в редакторе растровой графики, инструментами, средствами обработки и 
комбинации фотографических изображений создать законченные графические 
проекты по следующим направлениям. 

1. Создать индивидуальный портрет в рамке, применяя к обработке импор-
тированного портрета выделение, ретушь, тоновую коррекцию. К рамке приме-
нить эффекты слоя с 3D-эффектами, текстуры различных материалов.  

2. Тематическая композиция-коллаж из обработанных импортированных 
изображений на произвольную тему. 

3. Поздравительная открытка с использованием рисунков, импортирован-
ных изображений, 3D-эффектов текста, художественных фильтров. 

Разработанный графический образ сопроводить исходным изображением и 
подробным описанием последовательности применения инструментов для по-
лучения эффектов слоев, составляющих итоговое изображение проекта. 

На рис. 3.6–3.8 приведены проекты, выполненные студентами. 
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Рис. 3.6. Макеты поздравительных открыток 
 

 
  

 
Рис. 3.7. Рамки с портретами 

  
 

Рис. 3.8. Проекты с композициями-коллажами 
 

Лабораторная работа №4 
 

Освоение анимации и разработка анимационных проектов 
в Macromеdia Flash MX 2004 

 
Цель работы: 
1. Освоить работу с инструментами рисования в Macromеdia Flash: 
а) работа с текстом. Преобразование текста в символ. Преобразование 

символа текста в фигуру;  
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б) создание пошаговой анимации; 
в) создание и редактирование символов и экземпляров символов. 

2. Кадрированная анимация движения:  
а) вращения, трансформации; 
б) изменения цвета. 

3. Кадрирование движения по заданной траектории: 
а) задание движения с ориентированием по направлению движения. 

4. Кадрирование изменения формы: 
а) кадрирование изменения формы и цвета; 
б) кадрирование изменения формы объекта с текстом. 

5. Анимация в многослойном изображении: 
а) создание анимационных клипов и кнопок; 
б) создание клипов с изменяемыми текстовыми полями; 
в) задание для кнопок функции управления событиями в фильме; 
г) монтирование фильма с многослойной анимацией и включением сим-

волов типа «movie clip». 
 

Принципы анимации в Macromеdia Flash MX 2004 
 
Flash – революционная по своим возможностям система, предоставляю-

щая невиданную прежде свободу творчества. Представляя уникальный синтез 
графики, анимации и программирования, эта технология позволяет легко справ-
ляться с невероятно сложными для интернет-технологий задачами. Главное 
преимущество Flash – возможность делать интерактивные элементы интерфей-
са. Освоив Flash, вы сможете создавать баннеры, собственные игры, мульт-
фильмы, презентации. Однако не стоит излишне увлекаться и создавать во 
Flash целые веб-страницы. Flash – всего лишь один из инструментов, такой же 
как HTML, JavaScript, CSS (каскадные таблицы стилей). Каждая из этих техно-
логий может эффективно решать свои задачи. С помощью Flash отлично полу-
чаются меню, заставки и баннеры – не стоит поручать ему большее. Графика во 
Flash представляет собой комбинацию растровой и векторной графики, соеди-
няя в себе положительные стороны обоих графических представлений. 

 
4.1. Методические указания по работе в редакторе 

Macromedia Flash MX 2004 
 

Символы и образцы. Символы – многократно используемые графические 
образы, которые создаются с помощью инструментов рисования. При помеще-
нии символа на рабочее поле (Stage), создается его образец (Instance). Приме-
нение символов уменьшает размер файла, т.к. независимо от того, сколько об-
разцов создано, Flash сохранит в файле только одну копию. В символы 
желательно преобразовывать каждый элемент, который применяется в клипе 
более одного раза. Изменение параметров любого образца не влияет на вид 
мастер-символа, в то же время редактирование мастер-символа разом изменяет 
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все образцы. Можно изменить рабочее поле, показывая символ отдельно или же 
выделив его из окружения других элементов, которые в этом случае отобража-
ются на рабочем поле более блеклым цветом. Можно редактировать символ в 
отдельном окне. В режиме редактирования монтажная линейка показывает 
временную динамику только редактируемого символа. 

Краткий обзор методов анимации. Анимация в программе Flash создает-
ся путем изменения содержания последовательно расположенных кадров. Пе-
ремещение объектов по рабочему полю, увеличение или уменьшение их, вра-
щение, изменение цвета, формы, постепенное появление или такое же 
исчезновение и прочее. Изменения могут происходить независимо друг от дру-
га и одновременно с изменениями в других слоях. Например, можно заставить 
объект постепенно появляться на рабочем поле, вращаясь.  

Имеются два метода создания анимации во Flash: покадровая анимация 
(при этом все изменения в каждом кадре задаются вручную) и автоматическая 
(tweened) анимация (при этом способе вручную задаются только длительность 
анимации, задаваемая числом кадров, а также начальные и конечные формы и 
взаиморасположение объектов (в ключевых кадрах), а все промежуточные зна-
чения генерируются (интерполируются) самой программой Flash. Покадровая 
(Frame-by-frame) анимация увеличивает размер файла намного больше чем 
tweened-анимация. Различают 2 вида автоматической анимации: 

– движение (Motion-tweening). Таким способом лучше всего изменяются 
координаты объектов на рабочем поле; 

– превращение (Shape-tweening). Этот способ применяют обычно для из-
менения формы объектов.  

Создание ключевых кадров. Ключевой кадр (Keyframe) – это кадр, где 
вы определяете изменения в форме и взаиморасположении объектов, участ-
вующих в процессе анимации. При создании покадровой анимации каждый 
кадр является ключевым. В автоматической (tweened) анимации вы определяе-
те ключевые кадры в важных пунктах анимации и позволяете программе Flash 
самой заполнить содержание кадров между ними. Flash отображает интерполи-
рованные кадры tweened-анимации в timeline-шкале как помеченные синим 
или зеленым цветом со стрелкой между ключевыми кадрами.  

Ключевые кадры, которые содержат какие-либо объекты, отображаются в 
timeline-окне черными точками. Пустые ключевые кадры отображаются как не-
закрашеные точки. Первый кадр слоя (Layer) всегда ключевой. Содержание про-
стых кадров каждого слоя (если они не участвуют в tweened-анимации) всегда 
полностью повторяет содержание предыдущего ключевого кадра. 

Анимация с использованием слоев (Layers). Каждая сцена (Scene) во 
Flash-фильме может состоять из любого числа слоев. Программа Flash не может 
в одном слое задавать различные анимационные эффекты для нескольких объ-
ектов. Слои нужны для того, чтобы разделить различные, но одновременно вы-
полняемые анимационные задания для каждого из перемещающихся или изме-
няющихся объектов. 
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Следует запомнить: 
1) если необходимо неодинаковым образом изменить форму или коорди-

наты нескольких объектов с использованием автоматической анимации в одном 
слое, то между ключевыми кадрами начала анимационных действий всегда 
должен содержаться пустой ключевой кадр (Blank Keyframe); 

2) если различные анимационные действия производятся с несколькими 
объектами одновременно, то каждый из них должен быть в отдельном слое; 

3) фоновый (самый нижний) слой содержит один или несколько статиче-
ских объектов. Каждый из дополнительных слоев содержит один анимирован-
ный объект. Работа сильно упростится, если в один момент времени вы будете 
редактировать объекты (или их свойства), лежащие в одном слое. 

Создание ключевого кадра 
1. Курсором выберите кадр, а в меню выберите Insert -> KeyFrame. 
2. Щелкните правой кнопкой мыши на кадре в timeline-окне и выберите 

Insert Keyframe (лучше всего для этой цели использовать кнопку F6) 
Для создания ряда ключевых кадров выберите несколько кадров в слое 

(это можно сделать, нажав левую кнопку мыши, и не отпуская ее увести указа-
тель вправо или влево) и нажмите F6. Автоматическая (tweened) анимация на 
timeline-окне отображается следующими процессами: 

 – автоматическое движение (Motion tweening) – ключевые кадры 
отмечены черной точкой, а промежуточные кадры tweened-
структуры заняты черной стрелкой на синем фоне;  

 – ключевые кадры автоматического изменения формы (Shape-
tweening) отмечены черной точкой, а промежуточные кадры 
tweened-структуры заняты черной стрелкой на зеленом фоне;  

 – пунктирная линия указывает на проблемы с анимацией;  

 – отдельные ключевые кадры отмечены черными точками. Светло-
серые кадры после ключевого кадра содержат то же самое, что и 
ключевой кадр без каких-либо изменений. Пустой ключевой кадр 
обозначается маленьким черным кружком; 

 – маленький символ «а» указывает на то, что ключевому кадру 
было назначено действие из диалогового окна свойств кадра 
(Properties Frame); 

 – красный флажок указывает на то, что ключевой кадр содержит 
метку или комментарий. 

 
Установка частоты кадров. По умолчанию устанавливается частота в 

пределах 12 fps (12 кадров в секунду – стандарт для QuickTime и AVI). Стан-
дартная частота смены кадров в кино – 24 fps.  

Использование статических объектов в процессе анимации. Для ани-
мации бывает необходимо использовать один и тот же объект (фон) на протя-
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жении всего анимированного фильма (с независимой анимацией в других сло-
ях). Для этого нужно проделать следующее: 

1. Создайте статический объект в первом ключевом кадре слоя (обычно 
фоновое изображение располагают в самом нижнем слое в timeline). 

2. Выберите пустой контейнер для кадра настолько правее ключевого кад-
ра, насколько нужно. 

3. Выберите из меню Insert -> Frame или просто нажмите F5. 
 

 
 

 
Рис. 4.1. Слои в timeline-окне  
отображаются как строки 

 
Рис. 4.2. Статический фон создается  

в первом ключевом кадре 
 
Еще один способ отображения фона на протяжении всего анимированного 

фильма: 
1. Создайте объект в первом ключевом кадре слоя. 
2. Удерживая кнопку Ctrl, щелкните левой кнопкой мыши на этом ключе-

вом кадре и перетащите его вправо.  
Flash может создавать два типа tweened-анимации. В первом, называемом 

Motion tweening (анимация типа «движение»), лучше всего задать позицию и 
размер объектов в ключевом кадре начала анимации, а в конечном задать изме-
нения позиции, размера, цвета и прозрачности объектов или задать вращение 
объектов. Во втором, называемом Shape tweening (анимация типа «превраще-
ние» или изменение формы), в ключевом кадре начала анимации задается на-
чальная форма объекта, а в ключевом кадре конца анимации – конечная форма. 
Flash интерполирует значения координат, размера или формы объектов для 
всех промежуточных кадров, создавая анимацию. 

Анимация движения (motion tweening). Используя этот тип анимации, 
Flash может автоматически изменять позицию и размер объектов, вращать и 
искажать их, изменять цвет объектов или заставлять их постепенно появляться 
или исчезать (изменением прозрачности – параметр alpha). Изменению всех 
этих свойств поддаются только объекты «Символ» (Symbol). Объекты «Текст» 
и «Рисунок» просто не имеют «свойств» в меню правой кнопки и соответствен-
но не могут их изменять. Чтобы применить анимацию «движение» к рисунку, 
сначала надо превратить его в символ (F8). Если у объекта «Текст» надо изме-
нить цвет или прозрачность, то придется сначала превратить его в «Символ».  
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Рис. 4.3. Позиция, размер и прозрачность объекта-символа были интерполиро-
ваны с использованием информации из первого и последнего ключевых кадров 

 
Для создания анимированного перемещения объекта или группы объектов 

нужно проделать следующее: 
1. Выбрать пустой ключевой кадр и создать в нем нужные объекты или пе-

ретащить символы из окна Library (или Window -> Library). 
2. Выбрать Insert -> Create Motion Tween. (Ключевой кадр с объектами в 

этот момент должен быть выделенным.) Если в этом ключевом кадре содержат-
ся несколько объектов (или один объект, но не типа «Символ»), все они будут 
сгруппированы в автоматически созданном символе с именем Tween x. 

3. Далее просто перейдите мышкой в этом слое timeline-окна на нужное 
количество кадров правее (пусть 20 кадров) и нажмите F5. 

4. Переместите этот объект типа «Символ» поближе к желаемой конечной по-
зиции. Самый последний простой кадр автоматически превратится в ключевой. 

 

 
 

5. Чтобы задать свойства анимации, можно просто дважды щелкнуть на 
кадре, в котором она начинается, или выбрать из меню правой кнопки на этом 
кадре Properties-Tweening. 

Если в процессе анимации изменяются размеры объектов, поставьте га-
лочку в окошке Tween Scaling. 

Можно заставить объект вращаться в процессе перемещения. За это от-
вечает раздел «Rotate» в меню свойств анимации типа «Движение». В этом раз-
деле можно выбрать, в какую сторону будет происходить вращение (по часовой 
стрелке или против часовой) и сколько раз объект совершит полный оборот на 
360 градусов. 

Окошко в Orient to Path Direction используется при создании анимации 
типа «Движение» по заданному пути.  

Движок, который расположен чуть ниже, отвечает за постоянство или 
непостоянство скорости движения объектов. Если переместить его левее, то 
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движение будет начинаться медленнее и его скорость будет плавно нарастать 
ближе к концу, и наоборот. 

Чтобы автоматически привязать символ к заданному пути перемещения, 
используется опция Snap to Guide. 

6. Для анимированного изменения цвета и прозрачности символа задают 
желаемые начальные и конечные значения цвета и (или) прозрачности. 

 

Tweening-движение по пути. Кроме обычных слоев во Flash имеются некото-
рые специальные виды слоев. Один из таких слоев называется Motion guide. Ис-
пользуя этот тип слоя в качестве «ведущего», можно заставить символы в «ведо-
мом» слое, двигаться по любому пути (например криволинейному или круговому). 

Для задания пути символов в процессе анимации «движение»: 
1. Создайте в timeline последовательность кадров, содержащих анимацию 

типа «Движение» (Motion). 
2. Проделайте одно из следующих действий: 
выберите из меню Insert -> Motion Guide; 
щелкните правой кнопкой мыши на названии слоя и выберите Add 

Motion Guide из контекстного меню. 
Flash создаст новый уровень выше существующего слоя с названием 

«Guide: название слоя» и со специальным значком левее названия. А название 
слоя сдвинется вправо – этот слой стал «ведомым». 

 

 
 

3. Рисовать путь нужно именно в слое Guide, используя инструменты Ка-
андаш, Линия, Круг, Прямоугольник или Кисть, чтобы задать желаемый 
путь перемещения.  

Если в свойствах ключевого кадра начала анимации у вас активна опция 
Snap to Guide, символ во всех ключевых кадрах анимации в ведомом слое ав-
томатически устанавливается своим центром (крестик) в ближайшую точку на 
только что нарисованной линии. 
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В ключевом кадре начала анимации переместите символ ближе к началу 
пути, а в последнем кадре – ближе к концу. 

4. Если вам хочется чтобы в основном ролике не отображались линии пу-
ти, по которым движутся объекты, сделайте слой Guide невидимым, щелкнув 
мышкой в столбце под рисунком глаза правее названия этого слоя. 

5. В анимации с движением по заданному пути с включенной опцией Orient 
to Path Direction символ в процессе перемещения плавно изменяет угол между 
своим основанием и направлением движения, начиная от угла, заданного в клю-
чевом кадре начала анимации, и заканчивая углом, заданным в ключевом кадре 
конца. 

Чтобы заставить двигаться по заданному пути объекты из произвольно 
взятого слоя, проделайте одно из следующих действий:  

Перетащите слой, содержащий анимацию, непосредственно под слой типа 
«motion guide». После этого этот слой автоматически станет ведомым и все объ-
екты из него автоматически выстроятся по пути, заданному в ведущем слое. 

Создайте новый слой под ведущим слоем типа «motion guide». Теперь 
при попытке задать анимацию типа «Движение» в этом новом слое все объекты 
будут перемещаться по заданному пути. 

Выберите из меню Modify -> Layer, поставьте галочку в окошке Guided 
диалога «Свойства слоя». 

Щелкните по названию слоя мышкой, удерживая кнопку Alt. При этом 
слой, содержащий анимацию, обязательно должен располагаться ниже слоя ти-
па «motion guide». 

Чтобы превратить ведомый слой снова в обычный, проделайте следующее:  
 перетащите этот слой выше слоя типа «motion guide»; 

 выберите Modify -> Layer и выберите тип слоя «normal»; 

 щелкните по названию слоя мышкой, удерживая кнопку Alt. 
 

Анимированное изменение формы объектов (Shape Tweening). Исполь-
зуя анимированное изменение формы объектов, можно добиться эффекта по-
добных трансформаций (morphing), заставляя один объект плавно превращать-
ся в другой. При этом типе анимации Flash может также плавно изменять 
расположение, размер и цвет объектов. В этом случае не происходит движения 
с сохранением формы, а только плавное «перетекание» объектов из одного по-
ложения в другое. Следует иметь в виду, что анимированные действия с изме-
нением формы можно производить только с объектами типа «Рисунок». Впро-
чем, объекты типа «Текст» и типа «Символ» легко можно превратить в 
рисунок, используя действие Break Apart (Ctrl+B). В отличие от анимации ти-
па «Движение», Flash может заниматься изменением формы сразу нескольких 
объектов типа «Рисунок» в одном слое. 
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Для задания анимированного изменения формы:  
1. Щелкните на названии слоя, чтобы сделать его текущим и вставьте клю-

чевой кадр в том кадре, где вы хотите, чтобы началась анимация.  
2. Создайте объект типа «Рисунок» (или превратите объекты других типов 

в рисунок) в ключевом кадре начала анимации. Используя любой инструмент 
из панели инструментов, задайте его начальную форму. 

Flash не может проводить анимацию по изменению формы символов, тек-
стовых блоков или растровых изображений. 

3. Создайте второй ключевой кадр, пропустив желаемое число кадров по-
сле первого ключевого кадра. 

4. В этом новом ключевом кадре создайте новый объект типа «Рисунок» 
или измените как-либо объект в этом новом ключевом кадре. 

Кроме изменения формы, можно также изменить цвет и координаты объ-
екта во втором ключевом кадре. 

5. Дважды щелкните на первом ключевом кадре в последовательности, 
чтобы открыть диалоговое окно свойств кадра (Properties Frame), или выбери-
те ключевой кадр в начале последовательности в меню – Modify -> Frame. 

6. В закладке Tweening диалогового окна свойств кадра выберите Shape из 
всплывающего меню. 

7. Выбор значения для опции Blend Type: 
если выбрано Distributive, получится анимация, в которой промежуточ-

ные формы являются более скругленными и более неправильными; 
если выбрать Angular, получатся более угловатые промежуточные фор-

мы анимации с максимальным сохранением углов и прямых линий. Опция 
Angular будет работать только при анимированном превращении объектов с 
острыми углами и прямыми линиями.  

8. Задание постоянной или непостоянной скорости превращения. 
Движок, который расположен чуть ниже, отвечает за постоянство или не-

постоянство скорости превращения. Если переместить его левее (ближе к «In»), 
то превращение будет начинаться медленнее и его скорость будет плавно на-
растать ближе к концу, и наоборот. 

Общий алгоритм кадрированной анимации формы объекта: 
1. Нарисовать объект. 
2. Вставить в нужном месте ключевой кадр. 
3. В панели Properties (Свойства) из раскрывающегося списка Tween вы-

брать вариант Shape. 
4. Лента анимации между первым и последним ключевым кадром зальется 

сплошным серым цветом. 
5. Анимацию формы можно сочетать: 
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а) с перемещением объекта; 
б) изменением его цвета; 
в) поворотом; 
г) модификацией размера; 
д) перекосом и т.п. (инструмент Трансформация). 
Все эти изменения производятся в последнем ключевом кадре. 
6. Анимацию формы можно осуществлять с заменой в последнем ключевом 

кадре первоначального объекта на другой объект («схожие» по форме). 
7. В виде анимации можно применять анимацию перетекания одного гради-

ента в другой и другие эффекты игры цвета. 
8. Все изменения производятся при выделенном объекте. Если выделение 

инструментом       с первого раза не срабатывает (выделение уже имеется), то 
его можно сбросить, нажав инструмент подвыделения      . 

9. Сделав нужные изменения формы в конечном ключевом кадре, возвраща-
емся в первый ключевой кадр и  в панели Properties (Свойства) из раскрываю-
щегося списка Tween выбираем вариант Shape. 

10. Серая полоса на ленте между первым и последним ключевыми кадрами 
становится зеленой, и на ней появляется сплошная стрелка раскадровки. 

Замечание. Чтобы анимация формы не «сломалась», нужно следовать ре-
комендациям:  

– каждый формируемый элемент создавать на отдельном слое; 
– всю анимацию формы свести к нескольким коротким и четким измене-

ниям формы. 
Для редактирования кадра или ключевого кадра:  
При копировании содержания кадра выбираем кадр или последовательность 

кадров (можно даже в нескольких слоях) и выбираем из меню Edit -> Copy Frames. 
Для размещения скопированных кадров в другом месте в анимации (или 

вообще внутри одного из символов) выбираем кадр, с которого начнется встав-
ка, или последовательность кадров, которая будет заменена в процессе вставки, 
и из меню Edit -> Paste Frames. 

Чтобы переместить кадры и их содержание, выбираем в timeline-окне кадр 
или последовательность кадров и перетаскиваем их в желаемое место окна. 

Чтобы изменить длину анимированной последовательности, перетаски-
ваем первый или последний ключевой кадр из ее состава (вправо или влево). 

Чтобы добавить новый кадр в анимацию, можно просто нажать F5. 
Чтобы удалить лишние кадры, выбираем кадр или последовательность 

кадров и затем щелкаем правой кнопкой мыши в пределах выбранных кадров и 
выбираем Delete Frame из контекстного меню.  

Для создания нового пустого ключевого кадра выбираем Insert -> Blank 
Keyframe.  

Чтобы изменить направление анимации, выбираем последовательность кад-
ров в одном или нескольких слоях, выбираем из меню Modify > Frames > Reverse. 
В начале и конце этой последовательности должны быть ключевые кадры. 
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Чтобы преобразовать ключевой кадр в обычный, выбираем ключевой 
кадр и из меню Edit > Clear Keyframe. При этом содержание этого кадра будет 
заменено содержанием предыдущего ключевого кадра. 

Прикрепление наборов инструкций (actions) к отдельному кадру 
(frame). Прикрепите набор инструкций (action) к отдельному кадру (frame) 
– для того, чтобы происходило определенное действие, когда клип доиграл 
до определенного кадра. Например, можно создать «петлю» (loop) внутри 
клипа. Для этого, например, на 20-м кадре нужно прописать указание «go to 
frame 10 and play» (вернуться на 10-й кадр и продолжить проигрывание 
клипа). Выполняя это указание, клип будет снова и снова доходить до 20-го 
кадра и возвращаться на десятый. Во избежание путаницы рекомендуется 
прописывать наборы инструкций (actions), относящиеся к отдельным кад-
рам (frame) в отдельном слое (layer). Слой, в котором имеется такой набор 
инструкций, будет помечен маленькой буквой «а» в монтажной линейке 
(timeline). 

Чтобы приписать набор инструкций к ключевому кадру (keyframe):  
1. Выделите кадр в монтажной линейке, выберите Modify > Frame или 

просто дважды нажмите мышкой на ключевом кадре (keyframe).  
Если какой-нибудь ключевой кадр не активен, то набор инструкций при-

пишется к «первому попавшемуся» кадру, который находится перед текущим 
кадром, на котором находится указатель мыши. 

2. Щелкните мышкой на меню Actions, потом нажмите на + (плюс) и вы-
берите указание из всплывающего меню. 

В зависимости от того, какое действие вы выберете, в разделе с парамет-
рами появятся разные возможности задать параметры действия.  

3. Создайте несколько инструкций, чтобы происходило несколько дейст-
вий, когда клип достигает определенного кадра.  

Flash вставляет каждое новое указание под тем, которое как раз маркиро-
вано. С помощью кнопок «вверх» и «вниз» (это те самые, со стрелочкой, напро-
тив кнопки с плюсом) можно перемещать целые указания в списке. 

Проигрывание и остановка клипа. Когда клип «запускается», он проиг-
рывается вперед по всем кадрам, если не существует других указаний. Чтобы 
остановить или запустить клип в конкретном месте, используйте команды Play 
и Stop. Например, можно остановить клип перед переходом в другую сцену 
(Scene). После остановки клип не будет проигрываться дальше до тех пор, пока 
его не запустят снова. Используйте команду Play, чтобы запустить клип.  

Команды Play и Stop чаще всего используются, чтобы контролировать му-
ви-клипы (movie clips) с помощью кнопок. Для этого муви-клип должен иметь 
имя, и к нему следует обращаться с помощью команды Code->Tell Target.  

Смена кадра или сцены. Чтобы перейти на конкретный кадр (frame) или 
на конкретную сцену (Scene), используйте команду Goto. При переходе на дру-
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гой кадр вы можете выбрать: останавливать ли проигрывание клипа на этом 
кадре или продолжать проигрывать клип, начиная с этого места. По умолчанию 
клип остановится на указанном кадре.  

Команда GotoandPlay заставляет клип продолжить проигрывание после 
того, как клип перепрыгнет на желанный кадр. Если эта функция не включена, 
клип остановится на этом кадре. 

Публикация Flash-клипов. Используйте команду Publish, чтобы подго-
товить все требуемые файлы для отображения Flash-клипа в сети. Кроме самого 
Flash-клипа необходимо создать ряд документов, формат которых отображается 
автоматически, если Flash-плейер не доступен, например, HTML-документ, тре-
буемый, чтобы отобразить клип (или дополнительные изображения) в браузере. 
 

1. Выберите File -> Publish Settings. 
2. Выберите опцию для каждого файла формата, который вы хотите создать. 
Когда вы выбираете формат, для которого Flash предлагает дополнитель-

ные параметры настройки, новая позиция табуляции появляется выше текущей 
панели в диалоговом окне. Когда вы выбираете формат изображения типа GIF, 
JPEG или PNG, Flash автоматически добавляет требуемый код HTML, чтобы 
отображать изображение, если Flash-плейер не доступен.  

3. Введите уникальное название для файла или выберите Use Default 
Name, чтобы создавать каждый файл, используя название файла Flash с расши-
рением соответствующего формата.  

4. Нажмите позицию табуляции для параметров формата, которые вы хо-
тите изменить. Определите параметры настройки для каждого формата. На-
жмите Publish, чтобы генерировать все указанные файлы, когда все готово, или 
нажмите OK, чтобы закрыть диалоговое окно без публикации.  

Flash генерирует файлы, как определено в настройках. Выберите File-> 
Publish, чтобы сгенерировать файлы во всех указанных форматах. 

 
Краткий обзор публикации и экспорта. Для показа Flash-фильма в браузе-

ре необходимо сначала открыть HTML-документ, который в свою очередь акти-
визирует выполнение Flash-фильма. В дополнение к этому HTML-документу 
можно создать версию статического графического отображения вашего Flash-
фильма в формате JPEG или GIF, чтобы показать ее, если у пользователя не уста-
новлен Flash-плейер.  

Формат расширения главного файла для содержимого Flash – .swf. В до-
полнение к формату Flash-плейера, можно экспортировать клипы и создавать 
изображения Flash в ряде форматов, таких как GIF, JPEG, PNG, BMP, PICT, 
QuickTime или AVI.  

Настройка параметров HTML. Чтобы запустить клип Flash в сетевом 
браузере, нужно создать документ HTML, который активизирует клип и 
определит параметры настройки браузера. Можно использовать Publish, чтобы 
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генерировать требуемый документ HTML автоматически. Имеются параметры 
HTML, которые определяют, где клип Flash появится в окне, цвет фона, размер 
клипа и так далее. Вы можете изменять эти и другие параметры настройки в 
панели «HTML» диалогового окна Publish Settings. 

 
 

4.2. Указания к индивидуальной разработке анимационных проектов 
в редакторе Macromedia Flash MX 2004 

  
Выполнить самостоятельно следующие многослойные анимационные 

проекты: 
1. «Движение автомобиля по криволинейной дороге»: 
а) для траектории использовать направляющий слой; 
б) эффект передвижения подчеркнуть анимацией окружающего фона; 
в) на отдельном слое анимировать вращение колес. 
2. Анимационный проект «Дождь»: 
а) анимация отдельной капли с использованием типа анимации формы; 
б) превратить движение одной капли в символ типа «movie clip»; 
в) создать многослойную анимацию дождя путем вынесения множества 

экземпляров символов «капля» на рабочую ленту фильма «Дождь»; 
г) разместить на timeline-шкале случайным образом время запуска каждо-

го экземпляра символа «капля». 
3. Многослойный анимационный проект «Часы с ходиками»: 
а) нарисовать фон – циферблат с делениями; 
б) образы часовой и минутной стрелки превратить в символы. Перенести 

регистрационные точки символов. Реализовать анимацию вращения вокруг 
точки привязки в центре циферблата. Синхронизировать движение стрелок с 
использованием системных функций ActionScript. 

 
 

Лабораторная работа №5 
 

Разработка дизайна веб-сайтов 
 
Цель работы: 
1. Ознакомиться с основными принципами и концепциями разработки веб-

ресурсов. 
2. Освоить основные маршруты в процессе разработки веб-ресурсов, ос-

новные виды сайтов, их назначение и функции.  
3. Освоить работу основных программных продуктов, применяемых для 

разработки дизайна и структуры веб-ресурсов. 
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Виды и функции сайтов. Цели и задачи их создания 
 

Сайт – это именованный набор информационных и программных блоков, 
организованных и размещенных в сети Интернет с заранее определенной целью 
и предназначенных для активного восприятия целевой аудиторией. Успех (эф-
фективность) сайта определяется, в основном, тремя компонентами: содержа-
нием, дизайном и так называемой «раскруткой». 

Важно, чтобы все три компонента соответствовали друг другу. 
Дизайн – это лицо сайта, и на лице, говоря образным языком, должен быть 

«написан успех». Это фундаментальное условие работы с людьми. 
Любой сайт – это индивидуальный продукт, который включает работу ди-

зайнера, программиста, кодировщика, проектировщика и менеджера (иногда 
все в одном лице). Как правило, в коммерческих IT-компаниях, занимающихся 
разработкой веб-ресурсов, процесс разработки сайтов разбивают на различные 
этапы. Это связано с более эффективным использованием рабочего времени и 
уменьшением сроков разработки ресурса. 

Прежде чем начать процесс создания веб-ресурса необходимо определить-
ся с тематикой сайта. Если создавать сайт только для того, чтобы он существо-
вал в сети, то это не принесет эффекта. Чтобы сайт, как в настоящее время го-
ворят, «состоялся», необходимо, чтобы он удовлетворял основному правилу – 
он должен быть еще кому-то нужен и  интересен кроме вас. 

Виды сайтов. Сайты разделяются на следующие  виды: 
1. Поисковые. 
2. Новостные. 
3. Коммерческие. 
4. Тематические. 
Теперь рассмотрим основные виды сайтов. 
Поисковые. Основное предназначение поискового сайта – это предостав-

ление своим посетителям возможности поиска сайтов, в которых содержатся 
ключевые слова, необходимые (и приведенные) посетителям поискового сайта 
(рис. 5.1). 
 

 
 

http://google.com http://yandex.ru 
 

Рис. 5.1. Главные страницы поисковых Google и Яндекс 
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Концепция дизайна поискового сайта сводится к основным правилам: 
1. Простота дизайна. 
2. Скорость загрузки для пользователя. 
Эти правила продиктованы тем, что основные функции поисковых сайтов 

связаны с предоставлением информации, а не эффектных изображений, пред-
ставляющих лицо поискового сайта. Поэтому, несмотря на простоту дизайна, 
поисковые сайты посещают ежедневно не менее 1 млн человек. Как показано 
на примере Google (http://google.com) (см. рис. 5.1) дизайн сделан очень просто: 
логотип сайта (компании), несколько надписей, помогающих в навигации, поле 
ввода ключевых слов, по которым ведется поиск, и кнопка запуска поиска. 

Новостные. Основное предназначение новостных сайтов – это предостав-
ление новостной, своевременно обновляемой, информации для посетителей. 
 

 
 

http://lenta.ru 
 

Рис. 5.2. Главная страница новостного сайта Lenta.ru 
 
Дизайн новостного сайта. В верхней части новостных сайтов находятся: 

логотип сайта, его название, текущая дата, данные издания или правообладате-
ля, интерактивные баннеры и ссылки главных новостей, наиболее «проплачен-
ные» рекламные баннеры и рекламные ссылки. Обычно слева располагается 
меню, которое отражает постоянные рубрики новостей. По центру страницы 
размещаются главные новости, сюда включается фотография (как правило, она 
располагается сверху), название новости и аннотация. Правее главных новостей 
идёт колонка с второстепенными новостями, сюда включается название ново-
сти и очень краткая аннотация. Дизайн новостного сайта способствует предос-
тавлению наиболее широкого спектра информации. 

Коммерческие. Коммерческий сайт (компании или предприятия) должен 
решать следующие задачи: 

– представление фирмы или предприятия в сети Интернет; 
– расширение числа потенциальных потребителей; 
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– поддержка так называемого «бренда» – повысить узнаваемость;  
– широкое информирование и создание благоприятного мнения о деятель-

ности компании или предприятия. 
Как правило, такой ресурс состоит из следующих разделов: контактная ин-

формация, информация о компании, услугах, видах деятельности или произво-
димой продукции. В зависимости от сферы деятельности и от желания заказчика 
могут быть добавлены еще информационные страницы и интерактивные формы. 

Дизайн корпоративных сайтов определяется корпоративным стилем самой 
компании и сферы её деятельности. Расположение меню, элементов навигации, 
блоков основной информации, блоков для проведения опросов и т.д. должны  
подчиняться одной цели – удобство пользования сайтом. Тем не менее, иногда 
неординарные решения в расположении элементов корпоративных сайтов при-
носят ощутимое увеличение посетителей. 

Расположение информационных блоков. Количество и расположение ин-
формационных блоков корпоративных сайтов зависит от задач, возлагаемых на 
проект, и содержания информации. Основной принцип – чем проще, тем лучше. 

На практике используется одно из трех устоявшихся решений, отвечаю-
щих основным требованиям веб-дизайна – простоте и наглядности (рис. 5.3): 

 
A. Одна колонка – простая страничка с последовательно идущими картин-

ками и текстом. 
B. Две колонки – основная широкая колонка, содержащая текст, дополни-

тельная (более узкая) располагается справа или слева. 
C. Три колонки – основная колонка в центре, по бокам – дополнительные 

колонки. 

 
 

 
http://сoca-cola.by 

 
http://microsoft.com  

 
Рис. 5.3. Информационная страница cocа-cola.by и страница портала Microsoft 

 
Кроме вертикального деления в веб-дизайне используется и горизонталь-

ная разметка страниц. Вспомогательные колонки и блоки используются для на-
вигации, размещения новостей, рекламы, анкет, технической информации 
(кнопки счетчиков, специализированные формы, логотипы). Использование бо-
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лее сложных вариантов веб-дизайна оправдано в редких случаях и диктуется 
привязкой к контенту (информационному содержанию).  

Навигация по сайту. Если рассматривать взаимодействие человека и ма-
шины несколько шире, чем набор кнопок, то необходимо отметить, что интер-
фейс – это не только система навигации по сайту, но и часть дизайна, подчи-
няющаяся своим специфичным требованиям. 

• Все функции элементов интерфейса должны быть интуитивно понятны.  
• В рамках одного проекта должен использоваться только один вариант ди-

зайна интерфейса.  
• Интерфейс это не реклама. Он должен быть четко выражен в рамках об-

щей концепции дизайна сайта, но не должен отвлекать от содержания страниц. 
• В проектах с большим объемом информации и сложной структурой кро-

ме элементов навигации необходимо использовать элементы индикации, пока-
зывающие местоположение данной страницы в структуре сайта.  

Также необходимо соблюдать и более общие требования к дизайну, накла-
дываемые психофизиологическими особенностями восприятия.  

Видимость. Важная информация (элементы управления) должна нахо-
диться на переднем плане. Интерфейс должен фокусироваться «вокруг» объек-
тов, ради которых создавался сайт.  

Понимание. Меню в той или иной степени должно отражать структуру 
сайта, это поможет понять, куда нужно идти для получения искомой информа-
ции. Попав пару раз не туда, посетитель потеряет интерес и, скорее всего, по-
кинет сайт, так и не став его клиентом. При работе с большим объемом инфор-
мации понимание предпочтительней запоминания. 

Память. Доказано, что кратковременная память человека ограничена се-
мью элементами информации. Семь – это усредненное значение, обычно это 
значение меняется в пределах от 5 до 9. Поэтому, если есть возможность, ори-
ентироваться нужно на цифру 5, а не 7. Из этого вытекают следующие эмпири-
ческие рекомендации: 

В простом меню количество пунктов не должно превышать 7. Если пунк-
тов в меню больше, их надо разбить на группы. При этом групп должно быть не 
более 7, количество пунктов в одной группе не должно превышать 7.  

Что это дает? Если меню сайта запоминается при первом взгляде, это сразу 
помогает понять: 

• о чем сайт (в первом приближении);  
• какую информацию он содержит;  
• где искать нужную информацию.  
Кроме того, меню сохраняется в памяти во время работы с сайтом, что де-

лает работу более удобной и понятной. Если меню сайта более длинное, то вряд 
ли его дочитают до конца (рис. 5.4). 
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Рис. 5.4. Примеры расположения информации на сайтах 
 

Восемь отличий профессионального веб-дизайнера 
 

1. Профессиональный дизайнер не пользуется раздаваемой бесплатно гра-
фикой для «оформления сайтов». Качество таких картинок, кнопок, линеек и 
т.п. – третьесортное.  

2. Хороший дизайнер не будет использовать яркие, навязчивые, псевдона-
туральные текстуры, типа «под дерево» или «небо с облаками». А если и будет, 
то с величайшей осторожностью. И организует композицию так, чтобы тексту-
ра хорошо сочеталась со всеми остальными элементами. 

3. Опытный дизайнер не будет пользоваться псевдотрёхмерными надпися-
ми, которые выглядят искусственно, если к тому же подчёркнуты псевдонату-
ральными текстурами. В сочетании с трёхмерными кнопками, линейками и так 
далее эти эффекты ещё больше разоблачают неправдоподобность друг друга 
тем, что источники освещения у них находятся в разных точках.  

4. «Профи» своего дела не будет использовать раздражающие глаза и от-
влекающие от содержания разного рода мигания надписей, движения, враще-
ния и трёхмерные превращения текста. 
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5. Профессиональный дизайнер не забивает свои страницы бесполезными 
и только удлиняющими время загрузки аплетами, скриптами (например часа-
ми). Этими вещами увлекаются непрофессионалы, которым хочется хоть как-то 
украсить свои страницы.  

6. Мастер веб-дизайна не загромождает статусную строку браузера пользо-
вателя ненужными надписями, приветствиями и подобным хламом. 

7. «Продвинутый» веб-дизайнер не будет пользоваться всплывающими ок-
нами или открывать окно браузера на весь экран. 

8. Вдумчивый дизайнер заботится о тех, кто будет смотреть его сайт. Он 
всеми силами старается уменьшить время загрузки сайта, оптимизируя графику 
и текст. Делает дизайн ненавязчивым и удобным. 
 

5.1. Указания к индивидуальной разработке веб-страницы 
и публикации ее на сайте БГУИР 

 
1. Создание стиля и макета дизайна тематической веб-страницы под назва-

нием «Моя галерея», «Наша группа», «Моя семья», «Наш праздник», «Где я хо-
тел бы побывать», «Полет фантазии», «Мой близкий человек» с помощью гра-
фического редактора Adobe Photoshop и Image Ready. 

2. Для конструирования и публикации сайта в Интернете (на сайте БГУИР) 
использовать редактор DreamWeaver. В качестве графических материалов ис-
пользовать свои графические и анимационные работы.  

3. Все изображения графических проектов растрировать и оптимизировать 
посредством программы Adobe Image Ready. 

4. Создать дизайн элементов меню, навигации и ролловеров (элементов веб-
страницы, меняющих свой вид в разных ситуациях). 

5. Собственные анимационные проекты использовать в качестве реклам-
ных баннеров. 

6. Разработать собственный стиль сайта и зафиксировать его с использова-
нием CSS. Разработку стиля сопроводить описанием предлагаемых решений. 
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